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Take a look at all HP Support has to offer!

Thank you for your purchase. Along with your product, you receive a variety of
support services from Hewlett-Packard and our support partners designed to give
you the results you need, quickly and professionally.

Online Services: for 24-hour
access to information over your
modem, we suggest these
services.

World Wide Web URL—Printer drivers, updated HP printer software, and product and
support information may be obtained from http://www.hp.com, or in Europe from
http://www2.hp.com. In Japan printer drivers may be obtained from
ftp://www.jpn.hp.com/drivers/. Korea: www.hp.co.kr. Taiwan: www.hp.com.tw, with a local
driver website of www.dds.com.tw.

HP Bulletin Board Service—Our electronic download service provides convenient
access to HP printer drivers, updated HP printer software, product information, and
troubleshooting hints. Dial (208) 344-1691 (U.S. and Canada) and set your
communication software to N,8,1. European Bulletin Board Service numbers are listed
at http://www2.hp.com. Taiwan: (886-2) 923-3233. Korea: HITEL or CHOLIAN (Go
HPK). Australia: (613) 9890 0276. New Zealand: (649) 356-3660.

America OnLine—(America OnLine/Bertelsmann available in France, Germany, and
UK)—Printer drivers, updated HP printer software, and support documentation are
available to help you answer your HP product questions. Use Keyword HP to start your
tour.

CompuServe—Printer drivers, updated HP printer software, and interactive sharing of
technical information with other members are available on CompuServe’s HP User’s
forums (GO HP), or call (800) 524-3388 and ask for representative #51. (CompuServe
is also available in the UK, France, Belgium, Switzerland, Germany, and Austria.)

Obtaining Software Utilities
and Electronic Information:
U.S. and Canada

Asia-Pacific Countries/Regions

Australia/New Zealand

Phone: (970) 339-7009 Mail: Hewlett-Packard
Fax: (970) 330-7655 P.O. Box 1754

Greeley, CO 80632 USA

Fulfill Plus (65) 740-4477 (Singapore, Malaysia, Indonesia, Hong Kong SAR).

Call (612) 565-6099.

HP Direct Ordering for
Accessories and Supplies

Call (800) 446-0522 (U.S.) or (800) 387-8164 (Canada).

HP Support Assistant
CD-ROM

This support tool offers a comprehensive online information system designed to provide
technical and product information on HP products. To subscribe to this quarterly service
in the U.S. or Canada, call (800) 457-1762. Fulfill Plus, (65) 740-4477 (Singapore,
Malaysia, Indonesia, Hong Kong SAR).

HP Service Information To locate HP-authorized dealers, call (800) 243-9816 (U.S.); (800) 387-3867 (Canada).

HP Service Agreements Call (800) 446-0522 (U.S.); (800) 268-1221 (Canada).

HP FIRST: HP FIRST Fax will deliver detailed troubleshooting information on common software applications and
troubleshooting tips for your HP product. Call from any touch-tone phone and request up to three documents per call.
These documents will be sent to the fax of your choice.

Australia
Austria
Belgium (Dutch)
Belgium (French)
Canada
China
Denmark
English outside of UK
Finland
France
Germany
Hong Kong SAR
India
Indonesia
Italy
Japan

(03) 9272-2627
0660-8128
0800-1-1906
0800-1-7043
(800) 333-1917
(86 10) 6505 5280
800-10453
(31 20) 681-5792
9800-13134
05-905900
0130-810061
(852) 2506-2422
(011) 622-6420
(21) 352-2044
1678-59020
(81 3) 3335-8622

Korea
Malaysia
Netherlands
New Zealand
Norway
Philippines
Singapore
Spain
Sweden
Switzerland (German)
Switzerland (French)
Taiwan
Thailand
United Kingdom
United States

(02) 769-0543
(03) 298-2478
0800-22-2420
(09) 356 6642
800-11319
(65) 291-7951
(65) 275-7251
900-993123
020-795743
0800 55-1527
0800 55-1526
02-719-5589
(02) 661-3511
0800-960271
(800) 333-1917
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Customer Support Options Worldwide

In addition to the phone numbers listed below, appendix B, “Warranty and Support
Information" contains worldwide sales and service addresses and phone numbers
for countries/regions not listed here.

U.S. and Canada:

Customer Support & Product
Repair Assistance

(Please refer to the warranty
chapter of this manual for
additional product repair
information.)

Call (208) 323-2551 Mon-Fri 6 am to 10 pm and Saturday 9 am to 4 pm (Mountain
Time) free of charge during the Warranty Period; however, your standard long-distance
phone charges still apply. Please have your serial number ready when calling.

Post-warranty telephone assistance is available to answer your product questions. Call
(900) 555-1500 ($2.50* per minute, U.S. only), or call (800) 999-1148 ($25* per call,
Visa or MasterCard, U.S. and Canada) Mon-Fri 7 am to 6 pm and Saturday from 9 am
to 3 pm (Mountain Time). Charges begin only when you connect with a support
technician. *Prices subject to change.

European Customer Support Center Language and In-Country/Region Options Available
Open Monday-Friday 8:30-18:00 CET

HP provides a free telephone support service during the warranty period. By calling a telephone number listed below, you
will be connected to a responsive team waiting to help you. If you require support after your warranty has expired, you
can receive support for a fee through the same telephone number. The fee is charged on a per-incident basis. When
calling HP please have the following information ready:
• Product name and serial number Date of purchase Description of the problem

Dutch Belgium: 02 626 8806
Netherlands: 020 606 8751

English Ireland: 01 662 5525
UK: 0171 512 5202
International: 44 171 512 52 02

French France: 04 50 43 9853
Belgium: 02 626 8807
Switzerland: 084 880 1111

German Germany: 0180 5 25 81 43
Austria: 0660 6386

Norwegian Norway: 22 11 6299
Danish Denmark: 3929 4099
Finnish Finland: 0203 47288
Swedish Sweden: 08 619 2170
Italian Italy: 02 26410350
Spanish Spain: 902 321 123
Portuguese Portugal: 01 441 7199

In-Country/Region Support Numbers

If you require support after your warranty has expired or additional product repair services, of if your country/region is not
listed below, please refer to the Worldwide Sales and Service Offices in appendix B.

Africa/Middle East
Argentina
Australia
Brazil
Canada
China

Czech Republic
Greece
Hong Kong SAR
Hungary
India
Indonesia
Japan
Korea

(41 22) 780-7111
(54 1) 781-4059/69
(03) 9272 8000
(55 11) 709-1444
(208) 323-2551
(8610) 6261-4174; 6261-4175;
6261-4176; 6262-5666
(42 2) 471 7321
(30 1) 689 64 11
800-7729
(36 1) 252 4505
(011) 6472366
(21) 350-3408
(31 20) 581-3318
(82 2) 3270-0700; outside
Seoul, call 080-999-0700

Malaysia
Mexico D.F.
Mexico Guadalajara
Mexico Monterey
New Zealand
Philippines
Poland
Portugal
Russia
Singapore
Switzerland
Taiwan
Thailand
Turkey

(603) 295-2566
(52 5) 326-4600
(52 3) 669 95 00
(52 83) 378 42 40
(64 9) 356-6640
(63 2) 894-1451
(48 22) 37-5065
(351 1) 301 7330
(7 095) 923-5001
(65) 272-5300
(41 1) 753 7111
(02) 717-9609
(662) 661-4011; 661-4012
(90 1) 224-5925
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Copyright Information
© 1997 Hewlett-Packard Company

All Rights Reserved.
Reproduction, adaptation, or
translation without prior written
permission is prohibited, except
as allowed under the copyright
laws.

Part number: C3998-90902
First Edition, May 1997

Documentation Warranty
Statement

The information contained in this
document is subject to change
without notice.

Hewlett-Packard makes no
warranty of any kind with regard
to this material, including, but not
limited to, the implied warranties
of merchantability and fitness for
a particular purpose.

Hewlett-Packard shall not be
liable for errors contained herein
or for incidental or consequential
damage in connection with the
furnishing, performance, or use of
this manual.

NOTE TO U.S. GOVERNMENT
USERS: RESTRICTED RIGHTS
COMMERCIAL COMPUTER
SOFTWARE: “Use, duplication or
disclosure by the Government is
subject to restrictions as set forth
in subparagraph (c) (1) (ii) of the
Rights in Technical Data Clause
at DFARS 52.227-7013.”

Material scanned by this product
may be protected by
governmental laws and other
regulations, such as copyright
laws. The customer is solely
responsible for complying with all
such laws and regulations.

Trademark Credits

PaperPort™ is a trademark of
Visioneer, Inc. in the United
States and other countries.

Microsoft®, Windows® and
MS-DOS® are U.S. registered
trademarks of Microsoft
Corporation. Lotus® and Lotus®
1-2-3® are U.S. registered
trademarks of Lotus Corporation.
Adobe Photoshop™ is a
trademark of Adobe Systems,
Inc., which may be registered in
certain jurisdictions. All other
products mentioned herein may
be trademarks of their respective
companies.

Material Safety Data Sheet
(MSDS)

The Toner Material Safety Data
Sheet (MSDS) can be obtained
by calling HP First at (800)
333-1917 or (208) 344-4809.
International customers should
refer to “Hewlett-Packard
Services Worldwide” at the front
of this manual for appropriate
numbers and information.

Canadian DOC Regulations

Complies with Canadian EMC
Class B requirements.

<<Conforme á la classe B
des normes canadiennes do
compatibilité électromagnétiques.
<<CEM>>.>>

FCC Regulations

This equipment has been tested
and found to comply with the
limits for a Class B digital device,
pursuant to Part 15 of the FCC
rules. These limits are designed
to provide reasonable protection
against harmful interference in a
residential installation. This
equipment generates, uses, and
can radiate radio frequency
energy, and if not installed and
used in accordance with the
instructions, may cause harmful
interference to radio
communications. However, there
is no guarantee that interference
will not occur in a particular
installation. If this equipment does
cause harmful interference to
radio or television reception,
which can be determined by
turning the equipment off and on,
the user is encouraged to try to
correct the interference by one or
more of the following measures:

• Reorient or relocate the
receiving antenna.
• Increase separation between
equipment and receiver.
• Connect equipment to an outlet
on a circuit different from that to
which the receiver is connected.

Consult your dealer or an
experienced radio/TV technician.

Note: Any changes or
modifications to the device not
expressly approved by HP could
void the user’s authority to
operate this equipment.

Use of a shielded interface
cable is required to comply
with the Class B limits of Part
15 of FCC rules.
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1

Set Up

Introduction

Congratulations on your purchase of the HP LaserJet 6L Printer and
Companion Printing Solution. Your HP LaserJet 6L Printer and
Companion work together so you can be more productive right at your
desk.

• Print—Produce high-quality 600 dpi documents right at your desk. The
printer’s fast speed and small size make it the ideal choice for a
personal printer.

• Copy—Make great-looking HP LaserJet copies. You can copy 10 to 20
originals (depending on the paper thickness) at a time to your HP
LaserJet printer, even with your computer turned off. Or, send the
document to your computer and adjust the size, brightness, and
contrast of the scanned document using the HP LaserJet Companion
Copier software. Then send multiple copies of the adjusted document to
a printer.

• Fax—Add input capability to your computer fax solution. Feed a
document into the HP LaserJet Companion, drag the thumbnail image
onto the fax icon, and send the fax to its destination.

• File—Store and organize documents in a filing cabinet on your
computer. Easily find that invoice, receipt, or business card from weeks
ago.

• Read—Scan pages directly into your word processor. Included optical
character recognition (OCR) software converts text from scanned
documents into a format that you can edit in your word processor.

EN Set Up 1-1
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Minimum System Requirements

Before setting up and installing your HP LaserJet 6L Printer and
Companion Printing Solution, make sure the following system
requirements are met.

• 486 processor

• 8 MB RAM (Windows® 3.1x) or
16 MB RAM (Windows 95)

• Bidirectional communication or ECP port

N o t e The HP LaserJet 6L printer also supports printing from DOS 5.0 and
above.

Checking Contents

Before you start the installation, check the contents of the box to make
sure that all parts for your HP LaserJet 6L Printer and Companion are
included. If you are missing any items or you notice any damage, notify
the dealer, mail order company, or HP sales office.

• HP LaserJet 6L Printer • HP LaserJet Companion Printer
Accessory

• HP LaserJet Toner Cartridge • HP LaserJet Companion Interface
Cable (connects the HP LaserJet
Companion to your computer)

• Printer Power Cord • HP LaserJet Companion Power Supply

• Software CD-ROM • Sheet of Printer Labels

N o t e Some packages include additional OCR software to support regional
language differences. Also, additional promotional software may be
included on other compact discs.

N o t e A high-quality IEEE-1284 Compliant Parallel Cable is recommended for
best performance. The IEEE-1284 Compliant Parallel Cable connects
the HP LaserJet Companion to the HP LaserJet 6L Printer, and is not
included in the box. You must purchase this cable separately.

1-2 Set Up EN
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Identifying Your Printing Solution’s
Parts

Identifying Your Printer’s Parts

Before using your printer, make sure you can identify the following parts:

A = Front Output Slot G = Paper Input Support

B = Paper Path Lever H = Single-Sheet Input Slot

C = Front Panel Button I = Paper Input Bin

D = Indicator Lights J = Paper Guides

E = Paper Output Bin K = Printer Door

F = Paper Output Support

Figure 1-1

1
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Identifying Your Companion’s Parts

A Output Slot
B Release Lever (for cover; one lever on each side)
C Paper Edge Guides
D Paper Supports
E Input Slot
F Paper Tray
G To PC button—scan (light gray)
H To Printer Button—copy (dark gray)
I Image Sensor Roller

J Paper Pick Roller
K Image Sensor
L Cover

Figure 1-2
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A Kingston Lock Latch
B To PC Connector
C To Printer Connector
D Power Connector
E Paper Release Lever

N o t e The Kingston Lock Latch is a connector used with a Kingston Lock to
secure devices to your desk. Contact you local dealer for availability.

Figure 1-3
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Setting Up Your Printing Solution

Step 1: Installing the HP
LaserJet Toner Cartridge

It is recommended that you use
HP LaserJet toner cartridges. HP has
designed the printer, toner cartridges, and
toner formula to work together to give you
optimal image quality from your printer.

C a u t i o n
To prevent damage, do not expose the
toner cartridge to light for more than a few
minutes. For extended periods outside the
printer, place the cartridge in a closed
drawer, return it to the original packaging,
or cover it completely with a cloth.

N o t e
Save the toner cartridge packaging for
possible cartridge storage and recycling.

1 Open the Printer Door by pulling it
toward you in a forward motion using
both hands.

2 Roll the toner cartridge back and forth
briskly to distribute the toner evenly
inside the cartridge.

3 Grasp the end of the clear sealing
tape on the side of the cartridge and
pull firmly to remove the entire length
of the tape. Once removed, the tape
should measure twice the length of
the toner cartridge or 490 mm (19.3
inches).

4 Hold the cartridge by the handle (so
that the arrows are facing the printer)
and slide it down and back into the
printer. The ends of the cartridge
slide into the black plastic grooves in
the printer. Push it firmly into place
and close the printer door.

N o t e
If toner gets on your clothing, wipe it off
with a dry cloth and wash clothing in cold
water. Hot water sets toners into fabric.
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Step 2: Attaching the Label
to the Printer

A sheet of labels was shipped in the
Paper Output Bin of your printer. You will
need to attach the label titled “Remove
Paper Before Reloading” to your printer.

1 Carefully remove the label from its
backing sheet.

2 Attach the label to the printer’s Paper
Input Bin.

As the label indicates, always remove and
realign all paper before reloading. By
doing so, you can reduce multiple paper
feeds or paper jams or both.
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Step 3: Loading Paper into
the Printer

Before loading paper into the printer, you
will want to raise the paper supports
located behind the Paper Input Bin and
the Paper Output Bin. Using paper
supports can help prevent unwanted
paper curl and paper jams. These
supports can be extended for different
lengths of paper.

1 Raise the paper support on the Paper
Input Bin until it snaps into place.

2 Insert up to 100 sheets of paper into
the Paper Input Bin. Be careful not to
overfill the bin.

3 Center the paper using the paper
guides on the Paper Input Bin.

4 Raise the paper support on the Paper
Output Bin until it snaps into place.

N o t e
When adding paper to an existing stack in
the Paper Input Bin, always remove and
realign all paper to avoid multiple paper
feeds or paper jams or both.
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Step 4: Connecting the
Parallel Cable

You will need to connect a parallel cable
(purchased separately) between your HP
LaserJet 6L Printer and Companion.

N o t e
For best results, it is imperative that you
use a high-quality IEEE-1284 compliant
parallel cable, such as the HP LaserJet
cable, between the printer and computer.
This cable supports all of your printer’s
advanced printing capabilities. If you
experience problems with your computer
not being recognized by your printer, you
may have a faulty cable.

1 Connect a parallel cable to your
printer. Be sure not to force the cable
on upside down.

2 Secure the cable by snapping the two
wire clips from the printer to the
cable. A secure cable helps prevent
communication problems between
the computer and printer.

The HP LaserJet Companion connects
between your computer and your printer.

3 Plug the opposite end of the parallel
cable into the To Printer Connector
on the HP LaserJet Companion.

C a u t i o n
If the cable does not attach easily, make
sure that you are using the correct cable
and plugging in the correct end. Forcing
the plug into the connection can cause
damage.
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Step 5: Connecting the
Interface Cable

1 Plug the interface cable that came
with your printing solution into the To
PC Connector on the HP LaserJet
Companion.

2 Plug the opposite end of the interface
cable into the parallel port on your
computer.

C a u t i o n
Be sure to connect the cable to a parallel
port on your computer rather than a serial
port. Connecting to the wrong port can
cause damage to your printer. See your
computer’s documentation for more
information about the computer’s ports.

3 Plug one end of the power supply into
the power connector on the HP
LaserJet Companion.

4 Plug the other end into a surge
protector or wall outlet.

5 Plug one end of the printer’s power
cord into the back of the printer first,
then plug the other end into a surge
protector or wall outlet.

6 The parallel cable now connects your
printer (C) to the HP LaserJet
Companion (B). The interface cable
connects the HP LaserJet
Companion (B) to your computer (A).

N o t e
Once the power is connected, the
indicator lights on the printer’s Front
Panel turn on and then blink in sequence.
The Error (top) light stays on if the Paper
Input Bin is empty.

You will not find an on/off switch on your
printer or Companion. After 15 minutes of
inactivity, the printer will automatically
shift to a powered-down state called
SleepMode.
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Installing the HP LaserJet 6L Printer
and Companion Using CD-ROM

The HP LaserJet 6L Printer and Companion CD-ROM installs the
drivers and the PaperPort for HP software onto your computer’s hard
drive. The CD-ROM contains software solutions that support both
Windows 3.1x and Windows 95.

N o t e You will be given the option to install the HP LaserJet 6L Printer
software or the HP LaserJet Companion software or both.

Installing the Software
1 Quit all applications, including virus checkers.
2 Insert the HP LaserJet 6L Printer and Companion compact disc into the

CD-ROM drive (usually D).
3 If you are running Windows 95, click Start and then click Run.
4 If you are running Windows 3.1x, click File from the Program Manager

and choose Run.
5 Type D:\SETUP in the Open Command Line box.
6 Click OK.
7 Follow the instructions on the screen to complete the installation.

N o t e The serial number has already been entered by HP. If you need to
re-enter the serial number, it is located on the back of the compact disc
case.

N o t e If you encounter a communication problem, you might need to change
your computer’s parallel port mode. For more information on changing
your parallel port mode, see the Guide to Changing the Parallel Port
Mode in Setup included with your HP LaserJet Companion.

During installation, if you get the message “HP LaserJet 6L printer has
not been found,” check the power cord connections and power source.
Also, make sure you are using a high-quality IEEE-1284 compliant
parallel cable. If, after checking these items, you still see the
“HP LaserJet 6L printer has not been found” message, click Continue to
proceed with the PCL driver installation.

If the installation could not be successfully completed, see the
Alternative Installation instructions later in this chapter.

N o t e If, after installing the software and restarting Windows 95, your computer
displays the message “New Hardware Detected” and lists the HP
LaserJet 6L printer, you will want to select “Do not install a driver
(Windows will not prompt you again)” and click OK.
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Making Floppy Disks Using the
MakeDisk Utility

If you do not have a CD-ROM drive, you can make a set of software
installation disks from the compact disc if you have access to a
CD-ROM drive. You will need a maximum of 10 blank 1.4 MB floppy
disks.

N o t e If you do not have access to a CD-ROM drive and need to order the HP
LaserJet 6L Printer and Companion software disks, see “Obtaining
Software Utilities and Electronic Information” in the support pages at the
front of this manual. You will receive the installation disks through the
mail.

To make disks
1 Insert the HP LaserJet 6L Printer and Companion compact disc into the

CD-ROM drive (usually D).
2 If you are running Windows 95, click Start and then click Run.

If you are running Windows 3.1x, click File from the Program Manager
and choose Run.

3 Type D:\MAKEDISK\MAKEDISK.EXE (or replace D with the appropriate
drive name) in the Open Command Line box.

4 Click OK.
5 Follow the instructions on the screen.
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Installing Software From Disks

The following section lists several different methods of installation. Use
the method that is appropriate for your computer system.

Standard Installation for Windows 95

This setup installs the HP LaserJet Printer and Companion software for
Windows 95.

1 Click Start, select Shut Down, choose Shut Down the Computer, and
click Yes.

2 Turn off your computer.
3 Turn on your computer and restart Windows 95. The “New Hardware

Found” screen appears.

N o t e If your computer does not display the message “New Hardware Found,"
you will need to follow these instructions: 1) Insert disk 1 into Drive A:
(or B:), 2) Select Start, then select Run, 3) Type A:SETUP
(or B:SETUP) and click OK, then 4) Follow the instructions on your
screen.

4 Select “Driver from Disk Provided by Hardware Manufacturer.”
5 Click OK. The “Install From Disk” screen appears.
6 Insert Disk 1 into Drive A: (or B:) and click OK.
7 Follow the instructions on your screen to complete the installation.
8 Remove the disk when the installation is complete.

Standard Installation for Windows 3.1x
This setup installs the HP LaserJet Printer and Companion software for
Windows 3.1x.

1 Insert Disk 1 into Drive A: (or B:).
2 Select File from the Program Manager and choose Run.
3 Type A:\SETUP (or B:\SETUP ) and click OK.
4 Follow the instructions on your screen to complete the installation.
5 Remove the disk when the installation is complete.
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Custom Versus Typical Installation

When installing software for the HP LaserJet 6L Printer and Companion,
you may see a dialog box asking if you prefer a Typical or a Custom
installation. The Typical installation installs all of the HP recommended
software.

If you choose to do a Custom installation, you will be asked whether you
want to install the host-based driver or the PCL driver. If you meet the
system requirements and your printer and Companion are connected
directly to your computer, select the host-based driver. If you meet the
system requirements and you are going to access the printer across a
network, select the PCL driver.

You will also need to decide if you want the HP LaserJet 6L Help files
installed. Select this option if you want to include online help files for
your printing software. Finally, you will be asked if you want TrueType
Fonts installed. Select this option if you want TrueType fonts.

N o t e By following the Alternative Installation instructions below, the PCL
driver files and some help files will be installed. This setup will not install
the status window.

C a u t i o n Make sure that you quit all software that is currently running, such as
Microsoft® Office Manager, virus checkers, and fax utilities.

Alternative Installation for Windows 95

1 Quit all software that is running.
2 Click Start, then select Settings/Printers.
3 Double-click on Add Printer.
4 Click Next until you come to the List of Printer Manufacturers.
5 Click Have Disk.
6 Insert Disk 2 if you ran MakeDisk and click OK. The name of the printer

driver will appear.
7 Click Next. Then click Next again.
8 Remove the disk when the installation is complete.

Alternative Installation for Windows 3.1x
1 Quit all software that is running.
2 From the Program Manager, open the Main group.
3 Open the Control Panel and Printers.
4 Click Add. A list of printers will appear on your screen with Install

Unlisted or Updated Printer highlighted.
5 Click Install.
6 Insert Disk 2 if you ran MakeDisk and click OK.
7 Follow the instructions on your screen to complete the installation.
8 Remove the disk when the installation is complete.
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Testing the Installation

After completing the setup process, test your HP LaserJet 6L printer, HP
LaserJet Companion, and the PaperPort software to ensure the setup
was successful.

Printing a self-test page with your HP LaserJet 6L
Printer
A self-test page can be useful in identifying your printer’s configuration
and to ensure that your printer is working properly.

To print a self-test page
1 Make sure that the Ready light is on and all other lights are off. If

necessary, wake up the printer by briefly pressing and releasing the
Front Panel button.

2 Now briefly press and release the Front Panel button again. The Data
light comes on and the Ready light blinks. Please wait for a self-test
page to print.

If the self-test page does not print, try the following:

1 Ensure that paper is loaded in the printer.
2 Check the printer’s Front Panel Indicator lights to determine the status of

your printer. Then, refer to “Printer Messages” later in this chapter.
3 Contact Customer Support for assistance (refer to the support pages at

the front of this manual for support options).
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To test the Companion’s installation

N o t e Before testing the Companion’s installation, see the precautions listed in
chapter 3, “Before Using the HP LaserJet Companion.”

1 Raise the paper tray and paper supports.
2 Place a document, face forward and top down, in the paper tray. Adjust

the paper edge guides by sliding them to the edges of the document.

3 Press [To[Printer] once. The feed mechanism will pull the page through
the HP LaserJet Companion. A copy of the page prints at your printer.

If you need to stop the page, press [To[Printer] again. To remove the
page, see chapter 5,“Clearing Paper Jams from the HP LaserJet
Companion.”

N o t e The HP LaserJet Companion does not support the Direct Copy feature
for network printers. For more information on the Direct Copy feature,
see chapter 3, “Using the Direct Copy Feature.”

Figure 1-4

Figure 1-5
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4 Place the document in the paper tray again, face forward and top down,
and adjust the paper edge guides.

5 Press [To[PC]. The feed mechanism will pull the page through the HP
LaserJet Companion.

N o t e If the page does not scan or you encounter a communication problem
when scanning, you may need to change your computer’s parallel port
configuration. For more information on changing your parallel port
configuration, see chapter 5, “Troubleshooting and Maintenance.”

The PaperPort software will start automatically. A thumbnail image (an
icon representing a scanned item) of the page appears on the
PaperPort software as the document is being scanned. When the scan
is complete, the thumbnail image disappears and the PaperPort
software automatically displays the scanned image.

If you need to stop the scan, press [To[PC] again. To remove the
document, see “Clearing Paper Jams from the HP LaserJet Companion”
in chapter 5.

6 From the PaperPort software, press [F1] or display the Help menu.
Choose the One-Minute Guide for a tutorial on using the PaperPort
software, if you did not choose to view it during the installation. (For
more information on using the PaperPort software, see chapter 4,
“Working in the PaperPort Software.”)

If the scanned image (thumbnail) accurately appears in the PaperPort
software, you have connected the HP LaserJet Companion to the
computer correctly and installed the PaperPort software successfully.

7 Print a document from an application on your computer to your LaserJet
6L printer. If the page prints, the LaserJet 6L printer and Companion are
ready to operate.

If the HP LaserJet Companion or the PaperPort software does not work
correctly, see chapter 5, “Troubleshooting and Maintenance." If you need
additional help, see the service and warranty information in the front of
this user’s guide and in appendix B.

Figure 1-6
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Uninstalling the Software

If necessary, you can remove the HP LaserJet Companion and the
PaperPort software components and references from your computer.

To uninstall the software
1 From the PaperPort program group in Windows, double-click the

Uninstall HP LaserJet Companion icon.
2 Follow the instructions on the screen to uninstall the HP LaserJet

Companion software.
3 When your computer is finished uninstalling the HP LaserJet

Companion software, double-click the Uninstall PaperPort icon.
4 Follow the instructions on the screen to uninstall the PaperPort software.

Files with a .MAX extension, which were created by the PaperPort
software, will not be deleted from your hard disk by the uninstall
software. To delete the files with a .MAX extension from the PaperPort
directory, use the File Manager in Windows 3.1x or Windows Explorer in
Windows 95.

N o t e You can also remove the HP LaserJet 6L Printer and Companion
software from your computer by accessing the HP 6L program group.
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Using Online Help

When you installed your HP LaserJet 6L Printer and Companion
software, you also installed online help. Online help contains detailed
procedures that guide you through any task you want to perform with
your printer. It provides information that is specific to the current printing
task. You can access online help by selecting Help in your HP LaserJet
6L program group.

Online help is also a troubleshooting tool. When problems occur, the
quickest way to find a solution is to access your online help.

Online help supports the following software topics:

• Installation—provides installation information.
• Overview—summarizes information about the printer driver, the status

window, and accessing online help.
• Driver Software—describes options available for your printer, such as

number of copies and paper size.
• Status Window—describes options and features of your printer and

gives detailed descriptions of status window messages.
• Troubleshooting—leads you through a question and answer

troubleshooting scenario to determine and resolve problems.
• How Do I—provides information on printing tasks.
• PaperPort Help—provides a tutorial and information on using your

PaperPort software. Access PaperPort Help within the HP for PaperPort
desktop.

N o t e Online help may not be available if you followed the Alternative
Installation instructions.
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Installing Memory Cards (DRAM)

Your HP LaserJet 6L printer is capable of
accepting any 70ns or faster (such as a
50ns), 5V, DRAM memory card meeting
JEIDA specifications.

Hewlett-Packard offers 1-, 2-, and 4-MB
DRAM memory cards.

N o t e
Some printer drivers have an adjustable
memory setting. After installing or
removing a memory card, this setting may
require an adjustment to reflect the new
memory total.

To install memory cards
1 Unplug the power cord from the

printer.
2 Open the Printer Door, remove the

toner cartridge, and close the Printer
Door. Protect the toner cartridge from
light while working on the printer.

3 Gently tip the printer onto its side so
that the memory cover is on top.

4 Remove the Memory Expansion
Cover by placing a finger through the
hole and pulling away from the printer.

5 Align the memory card with the
corner notch so it is positioned as
shown. Push it firmly into the printer.

Replace the Memory Expansion Cover,
set the printer upright, reinstall the toner
cartridge, load the paper, and plug the
power cord back into the printer.

Print a self-test page to ensure that the
printer recognizes the additional memory
you have added. Your Total Memory in
the “Printer Configuration” section will
show the new memory total.
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2

Printing

Before Printing

It is important that you become familiar with your printer’s front panel.
The Front Panel consists of one button and three indicator lights.

• Error (Amber)

• Data (Green)

• Ready (Green)

The lights will be in one of the following states:

On

Off

Blinking
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The Front Panel

Use the Front Panel to determine the status of your printer and to
accomplish the following tasks:

Status Condition Cause Action

No lights are on or blinking. Printer is in SleepMode or
power has been
disconnected.

If you wish to print, press
and release the Front
Panel button or send the
job to print. If no response,
check the power cord.

Ready light is on steadily. Printer is ready to print. No action is necessary.
However, if you press and
release the Front Panel
button, a self-test page will
print.

Data light is on steadily
and the Ready light is
blinking.

Printer is receiving or
processing data.

No action is necessary.

Data light and Ready light
both remain on.

Unprinted data is in the
printer.

Press and release the
Front Panel button to print
the remaining data.

Data light is blinking. Printer is in Manual Feed
mode.

Check that you have
loaded the correct paper.
Then, press and release
the Front Panel button to
print.

Error light remains on. Printer is out of paper.

Printer has a paper jam.

No toner cartridge.

Printer door is open.

Load paper.

Clear the paper path.

Install the toner cartridge.

Close the printer door.

Error light is blinking. Page may be too complex
for the printer’s memory
capacity.

See Chapter 5,
“Troubleshooting.”

All lights are on. Printer is indicating an
internal problem.

See Chapter 5,
“Troubleshooting.”

All three lights are flashing
simultaneously.

The memory card may be
slower than 70 ns.

See Chapter 5,
“Troubleshooting.”
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Selecting Print Media

The type of media you select affects printer performance and print
quality.

Selecting Media Types

If available in your area, it is recommended that you use HP LaserJet or
HP Multipurpose paper (since it has been designed specifically for use
with your printer) or paper meeting HP’s specifications. You can also use
recycled paper when the paper meets HP’s requirements. To order HP
paper or the HP LaserJet Printer Family Paper Specification Guide, see
“Accessories and Supplies Information” in appendix B.

Selecting Media Sizes

The Paper Input Bin holds up to 100 sheets of 75 g/m2 (20 pound) print
media. The Single-Sheet Input Slot holds one sheet. Both can be
adjusted to hold media measuring from 76.2 x 127 mm
(3 x 5 inches) to 215.9 x 355.6 mm (8.5 x 14 inches). This includes, but
is not limited to, the following paper and envelope sizes:

• Letter (8.5 x 11 in) • Legal (8.5 x 14 in) • Executive (7.25 x 10.5 in)

• A4 (210 x 297 mm) • COM10 Envelopes
(4.125 x 9.5 in)

• DL Envelopes
(110 x 220 mm)

• C5 Envelopes
(162 x 229 mm)

• B5 Envelopes
(176 x 250 mm)

• Monarch Envelopes
(3.875 x 7.5 in)

• Other Custom-Sized
Media

N o t e Insert all media lengthwise (vertically) into the printer. If you want to print
horizontally (landscape), make this selection through your software. Do
not print on paper smaller than 76.2 x 127 mm (3 x 5 inches).
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Selecting the Output Paper Path

C a u t i o n
To avoid paper jams, do not switch the
Paper Path Lever once printing begins.

1 Set the Paper Path Lever to the
upper position to use the Paper
Output Bin. By doing so, the sheets
will stack in the correct order.

2 Set the Paper Path Lever to the
lower position to use the Front
Output Slot. This straight-through
path is the best output option to print
postcards, transparencies, labels,
envelopes, and heavy paper (100- to
157-g/m2 [28- to 42-lb] bond weight).

C a u t i o n
Do not allow more than one transparency,
20 sheets of paper, or other media to
stack up in front of the Front Output Slot.
A paper jam could result.

Adding Paper

When adding paper to an existing stack in
the Paper Input Bin, always remove and
realign all paper before reloading to avoid
multiple paper feeds.
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Using the Single-Sheet Input Slot

You can print one sheet of print media at
a time without unloading the Paper Input
Bin. To do so, you will need to load one
sheet into the Single-Sheet Input Slot.
The printer will take from the Single-Sheet
Input Slot before it takes from the Input
Bin.

N o t e
The Single-Sheet Input Slot is helpful
when the first page of your job is different
from the rest. For example, you may want
the first page of your print job on
letterhead, or you may want to print an
envelope first.

1 Center the paper guides to the
approximate size of the sheet you are
using.

2 Insert one sheet of print media, print
side forward and top side down, into
the Single-Sheet Input Slot.

3 Readjust the paper guides to center
the sheet.
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Printing on Letterhead and Envelopes

Letterhead
1 If you are printing a sheet of

letterhead followed by regular sheets
of paper, place a sheet of letterhead
into the (A) Single-Sheet Input Slot
and regular sheets of paper into the
(B) Paper Input Bin. If you are printing
several sheets of letterhead in
succession, fill the Paper Input Bin
(B) with the letterhead.

2 Insert the letterhead with the print
side forward and the top side down.

N o t e
If printing on embossed or pre-printed
paper, make sure the paper meets HP’s
paper specifications. To order the HP
LaserJet Printer Family Paper
Specification Guide, see “Accessories
and Supplies Information” in appendix B.

Envelopes
If you are printing one envelope followed
by regular sheets of paper, place the
envelope into the (A) Single-Sheet Input
Slot and regular sheets of paper into the
(B) Paper Input Bin.

If you are printing several envelopes in
succession, fill the Paper Input Bin (B)
with up to 10 envelopes, depending on
envelope construction and operating
environment. (In some cases, you may
only be able to load up to 7 envelopes,
such as if you live in an area with high
humidity.)

If you are printing only one envelope, use
the Single-Sheet Input Slot.

3 Insert the envelopes print side
forward as shown.

4 Set the Paper Path Lever to the
Lower position to reduce wrinkling
and curling.
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Printing Tasks

Your HP LaserJet 6L Printer’s capabilities include duplex printing,
pausing between pages, and stopping a print job. You can also reset
your printer if necessary.

Printing on Both Sides (Duplexing)

When you print on both sides of a sheet, you may notice a difference in
the way the printer performs. When printing on the second side, you may
experience some difficulties such as getting the sheet to feed into the
printer, or multiple feeds. In addition, the print quality may be different on
the second side of the sheet. To minimize these problems, you will want
to use paper meeting HP’s paper specifications. To order HP paper or
the HP LaserJet Printer Family Paper Specification Guide, see
“Accessories and Supplies Information” in appendix B.

1 Print the first side of the sheet as you normally would. Some software
programs include options that are useful when duplex printing such as
printing just the “odd pages” or the “even pages.” Consult your software
user’s manual.

2 Allow the sheet to cool and flatten before printing on the second side to
get the best possible print quality.

3 Print the second side by placing the sheet back into the Paper Input Bin
or the Single-Sheet Input Slot. Make sure the printed side is facing the
back of the printer and the top edge of the paper is down, as illustrated
in Figure 2-1.

Tips for Duplex Printing

• To avoid paper curl, set the Paper Path Lever to the Lower position and
use the Front Output Slot for a straight-through paper path.

• To print one page at a time, select the Manual Feed option in your software
to pause the printer between pages.

• Make certain that the sheet’s leading edge is not bent or curled.

Figure 2-1
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Pausing Your Printer Between Pages

Occasionally, you may need the printer to pause so that you can load
special media, such as letterhead. If you specify Manual Feed in your
software, the printer will pause before the first page and between each
page you print. This will give you time to load the special media. To
resume printing, press and release the Front Panel button.

1 In your software’s printer menu or bin/tray selection, select the Manual
Feed mode.

2 From your software, print the document.
3 The Data light will blink when the page is ready to print, indicating that

the printer is paused and waiting.
4 After inserting the correct medium, briefly press and release the Front

Panel button to print the page. The printer will take media from the
Single-Sheet Input Slot first. If it does not find media in the Single-Sheet
Input Slot, it will take media from the Paper Input Bin.

Resetting Your Printer

Resetting your printer accomplishes the following:

• Clears all data from the printer’s memory (including unprinted data,
downloaded fonts, and macros).

• Finishes printing the current page.
• Removes some error conditions.
• Resets the printer to its factory default settings.

To Reset the Printer:
Press and hold the Front Panel button until the three indicator lights
begin to blink in succession (about 5 seconds), then let go of the button.
After resetting, the Ready light will remain lit if no printer errors are
found.

Stopping a Print Job

If the file you send to the printer is only one or two pages long, you can
stop the print job by resetting the printer as described above.

If you want to stop a large print job, follow the steps below:

1 Remove the media from the Paper Input Bin except for any sheet that is
currently being fed into the printer.

2 Stop and delete the print job through your software.
3 Reset the printer.
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Printing on Special Media

Your printer is designed to print on a variety of media, including
transparencies, envelopes, and custom-made paper. It is recommended
that you use HP media or media meeting HP’s specifications. See
appendix B, “Accessories and Supplies Information” to order HP’s
special media or the HP LaserJet Printer Family Paper Specification
Guide.

1 Set the Paper Path Lever to the Lower position to use the Front Output
Slot for a straight-through paper path. This is important when printing
media such as postcards, transparencies, labels, envelopes, and heavy
paper (100- to 157-g/m2 [28- to 42-pound] bond weight).

2 Adjust the paper guides to the approximate size of media you are using.
3 Insert the media print side forward and top side down into the

Single-Sheet Input Slot or the Paper Input Bin.
4 Readjust the paper guides to center the media.
5 Set the correct margins, paper size, and orientation in your software.
6 Choose Print in your software.

Additional Tips for Custom Sizes

• Do not print on media smaller than 76.2 mm (3 inches) wide or 127 mm
(5 inches) tall.

• Set margins of at least 6.4 mm (.25 inches) in your software.
• Always insert media lengthwise (vertically) into the printer. If you want to

print in landscape mode, make this selection through your software.

Additional Tips for Transparencies

To avoid transparency curl, remove the transparency as it comes out of
the printer and set it on a flat surface to cool.

Additional Tips for Printing Labels

• Do not use labels that are separating from the backing sheet or that are
wrinkled or damaged in any way.

• Do not use any sheet of labels that has spaces in it where some of the
labels have been removed.

• Do not feed a sheet of labels through your printer more than once.
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Managing HP LaserJet Toner
Cartridges

It is recommended that you use HP LaserJet toner cartridges. HP has
designed the printer, toner cartridge, and toner formula to work together
to give you optimal image quality from your printer. To order an HP
LaserJet toner cartridge, see “Accessories and Supplies Information” in
appendix B.

You can expect a toner cartridge to print approximately 2500 pages
when you are printing typical business letters with text covering about
5% of the page. A page containing graphics uses more toner and
shortens the life of the cartridge.

Extending Toner Life through EconoMode
An excellent way to extend the life of your toner cartridge is by using
EconoMode. EconoMode uses approximately 50% less toner than
normal printing. The printed image is much lighter, but is adequate for
printing drafts or proofs. You can set the EconoMode option through your
software (refer to online help for more information).

Extending Toner Life by Redistributing Toner
Areas of faded print are often an indicator that the toner cartridge is
near the end of its toner life. You can temporarily reestablish print quality
by redistributing the remaining toner in the cartridge. (This is typically
successful only one time.) Follow the steps below to redistribute the
toner:

1 Open the Printer Door and remove the toner cartridge.
2 Hold the toner cartridge by the handle and pull it toward you so that it

slides out of the plastic grooves. (Remember to protect the cartridge
from light.)

3 Briskly roll the toner cartridge back and forth to redistribute the toner
evenly inside the cartridge.

4 Reinsert the toner cartridge and close the door.

Recycling Toner Cartridges
To reduce landfill waste, HP has adopted a recycling program for empty
toner cartridges. A postage-paid shipping label can be found inside your
HP LaserJet toner cartridge box. Up to 95% of each returned toner
cartridge is recycled for use as raw materials in the manufacture of new
cartridges and in other industries. To join this recycling effort, follow the
instructions provided in the toner cartridge box.
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3

Using the HP LaserJet Companion

Before Using the HP LaserJet
Companion

The HP LaserJet Companion can copy and scan various types of items,
from business cards (2 by 3.5 inches, 5.1 by 8.9 cm) to 8.5- by 30-inch
(21.6 by 76.2 cm) pages. The HP LaserJet Companion also accepts 16-
to 28-pound (60 to 105 g/m2) bond papers, magazine pages, and
photographs.

However, you should not put anything in the HP LaserJet Companion
that could get stuck in or damage the feed mechanism. Observe the
following precautions to minimize the possibility of jamming the feed
mechanism:

• Remove self-stick notes.
• Do not scan any document with glue, white-out, or wet ink on it.
• Do not scan gummed-backed paper or labels.
• Remove staples and paper clips.
• Straighten any curls or wrinkles from documents.

T i p If you have problems feeding a page into the HP LaserJet Companion,
turn the page around and feed in the other end of the page.

• Avoid documents with tears or perforations.
• The paper tray will accept 10 to 20 (maximum) sheets at a time,

depending on the thickness of the sheets.
• Feed irregularly-sized sheets one at a time for better results.

T i p Tape newsprint, magazine pages, and other irregularly-sized items to a
regular size sheet to improve performance. If lightweight bond paper
misfeeds or causes poor performance, you can insert the page into a
carrier sheet. Make a carrier sheet by taping the short edge of a
transparency to a regular sheet of bond paper.

T i p For narrow media such as business cards and receipts, first slide the
paper edge guides as far apart form each other as possible. Then insert
your media as far as you can into the HP LaserJet Companion along the
left paper edge guide.
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Using the Direct Copy Feature

The Direct Copy feature allows you to print single copies of a document
directly from your HP LaserJet Companion to your printer with or without
your computer turned on. To make direct copies, your printer must be
directly connected to your HP LaserJet Companion.

N o t e You cannot print direct copies to a network printer. If you do not have a
printer connected to your HP LaserJet Companion, send the document
to your computer and then to the HP LaserJet Companion Copier
software to print from a network printer. For more information on using
the HP LaserJet Companion Copier software, see the “Using the HP
LaserJet Companion Copier Software” section later in this chapter.

T i p Direct copies are defaulted to print at 300 dots per inch (dpi) as black
and white images (no gray tones). For information on optimizing scan
settings for the item being scanned, see the “Adjusting the Copy and
Scan Quality” section later in this chapter.

To print single copies
1 Raise the paper tray and the paper supports.
2 Place the document face forward and top down in the paper tray, and

adjust the paper edge guides by sliding them to the edges of the
document.

N o t e You may need to change the paper size in the printer driver:

In Windows 95, select Start, then choose Settings, Printers, and
Properties. Select Paper and adjust your paper size.

In Windows 3.1x, select Main, then choose Control Panel, Printer, and
Setup. Select Paper and adjust your paper size.

3-2 Using the HP LaserJet Companion EN

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


3 Press [To[Printer]. The document feeds through the HP LaserJet
Companion, and your printer prints a copy.

If you need to stop the copy, press [To[Printer] again. To remove the
document, see “Clearing Paper Jams from the HP LaserJet Companion”
in chapter 5.

T i p Use the HP LaserJet Companion Copier software to make multiple
copies of a single document. For additional information on the HP
LaserJet Companion Copier software, see PaperPort Help.

Figure 3-1
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Using the HP LaserJet Companion
Copier Software

The HP LaserJet Companion Copier software works much like a
photocopier in that it allows you to enlarge or reduce the image, control
the brightness and contrast, control the number of copies made of an
item, and collate copies.

To send an image to the HP LaserJet Companion
Copier software

1 Raise the paper tray and the paper supports.
2 Place the document face forward and top down in the paper tray, and

adjust the paper edge guides by sliding them to the edges of the
document.

3 Press [To[PC] once. If you need to stop the scan, press [To[PC] again. To
remove the document, see “Removing Paper” in chapter 5.

The PaperPort software starts automatically. A thumbnail image of the
page appears on the PaperPort software as the document is scanned.
When the scan is complete, the thumbnail image disappears and the
PaperPort software automatically displays the scanned image in the
Desktop View.

4 After the scan is complete, select the document on the PaperPort
screen.

5 Drag the selected items onto the HP LaserJet Companion Copier link.
- Or -
From the File menu, choose Links and select HP LaserJet Companion
Copier link from the submenu.
- Or -
Select the item and click the HP LaserJet Companion Copier link.

The HP LaserJet Companion Copier software will start and show a
screen where you can adjust the copy quality and quantity.

Figure 3-2
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To adjust the copy size and quality

1 In the HP LaserJet Companion Copier screen, click Fit to Page to
create the biggest representation of the image possible without
distorting the image.
- Or -
Drag the Scale slider to adjust the size of the scanned image. The scale
will allow you to adjust the image in 25-percent increments.

2 Drag the Contrast slider to adjust the contrast.
3 Drag the Brightness slider to adjust the brightness.

N o t e The Contrast and Brightness options are only active if the image is
grayscale (more than 1 bit per pixel). If you adjust the scale, contrast, or
brightness on one page of a multipage document, these settings will
affect all pages. If you want to change the settings for only one page,
adjust and print that page then change the settings back for the
remaining pages.

You can double-click the word Scale to return the image to 100-percent
of the scanned size. You may also double-click the words Contrast or
Brightness to return the settings to the default settings.

T i p Use the page scroll arrows below the representation of the document to
move between pages.

Figure 3-3
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To print the copies
1 Type the number of copies to print in the Copies field.
2 Select which pages you want to print in the Range of Pages field.
3 If you select a range of pages and more than one copy, you can select

Collate to print the copies into sets.
4 Click Setup to setup the printer, if necessary.
5 Click Start to print the copies.
6 Click Cancel to quit the HP LaserJet Companion Copier software when

finished.
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Scanning Documents to Your
Computer

These procedures describe scanning a document and sending the
image to your computer, which is the first step to faxing, filing, and using
the OCR software.

To scan a document
1 Raise the paper tray and paper supports.
2 Place the document face forward and top down in the paper tray, and

adjust the paper edge guides by sliding them to the edges of the
document.

3 Press [To[PC] on the HP LaserJet Companion.

The scan will begin and a thumbnail image of the page appears as the
document is being scanned. When the scan is complete, the thumbnail
image will disappear and the PaperPort software will automatically
display the scanned image in Desktop View.

N o t e For information on how to give an item a new title, see “Giving Titles to
Items” in chapter 4.

If you need to stop the scan, press [To[PC] again. To remove the
document, see “Clearing Paper Jams from the HP LaserJet Companion”
in chapter 5.

T i p If you press [To[PC] and there is no paper in the HP LaserJet
Companion, the PaperPort software will start. For more information on
the PaperPort software, see chapter 4, “Working in the PaperPort
Software.”

Figure 3-4
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Using Fax Links

You can scan an item into the PaperPort software, add annotations, and
fax the item provided that your computer has access to a fax modem
and fax software.

N o t e For information on links, see PaperPort Help.

To send items using the fax link
1 In Desktop View, select the item you want to fax.
2 If you do not want the PaperPort annotations to appear in the faxed

item, switch to Page View and clear Show Annotations on the
Annotations menu.

3 Drag the item onto the Fax icon on the Link Bar.
- Or -
From the File menu in Page View, choose Links. Then select the fax
name from the submenu.
- Or -
Click the Fax icon.
- Or -
To send a fax from Page View, from the File menu, choose Links.

4 To complete the fax, refer to the documentation that came with your fax
software.

To read a fax in the PaperPort software
1 From the File menu, choose Import Fax. The Import Fax dialog box

appears and lists the faxed items available in the PaperPort software.
2 Select one of the faxed items on the list. A thumbnail of it appears in the

dialog box.
- Or -
Click Select All to convert all of the faxed items.

3 Click Import. The selected faxed item appears in Desktop View.
4 Display the item in Page View to read the fax.
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Using Electronic Folders

After scanning an item to your computer, you can file it in electronic
folders in the PaperPort software.

Filing Items in Folders

The PaperPort software provides you with an initial set of folders that
appears in a column down the left side of Desktop View.

To file an item in a folder
1 In Desktop View, select the item to file.
2 Drag it to the target folder. When the folder title is highlighted, release

the mouse button. The folder flashes to let you know the selected item
has been filed.

To copy items to another folder

• Hold down [Ctrl] as you select an item and drag the item on the new
folder. The title of the target folder flashes to let you know the selected
item has been copied and filed.

-or-

• Select the item. From the Desktop menu, select Copy to Folder, select
the target folder, and click OK. The PaperPort software copies the item
into the new folder.
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Displaying Items in Folders

The contents of a folder are always displayed in the order in which they
appeared when you last opened the folder.

To display items in a folder
Click the folder icon. Thumbnails of the contents of the folder are
displayed on the Desktop.

To display a list of folder contents
1 From the Edit menu, choose Browse.

- Or -
Click Browse on the Command Bar.
The Browse dialog box appears. In Desktop View, the dialog box lists all
of the folders and their contents. In Page View, only the contents of the
open folder are listed.

2 Select an item on the list to display its thumbnail.
3 Double-click the selected item. The item is displayed in Desktop View.

The icons to the left of the item’s name indicate which items are stacks
and which are single pages. You can see the pages of a selected stack
by clicking the Page Navigator on the thumbnail.

Creating Folders

Create, rename, or delete folders to match the way you organize
information. The Main Folder, at the top of the column, cannot be
deleted. It is the default folder into which all scanned items are placed if
the PaperPort software is not running when you scan the item. If the
PaperPort software is running and a folder is open, the item is filed
automatically in the open folder.

N o t e You can create only one level of folders; that is, you can not create
folders within folders.

To create a folder
1 From the File menu, choose New Folder.
2 In the New Folder dialog box, type the title for the folder. The title can be

up to 30 characters.
3 Click OK. The folder appears in the folder column. Folders are arranged

in alphabetical order, but the Main Folder is always first.
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Editing Scanned Images Using OCR
Links

Once text is scanned into the PaperPort software, the text becomes an
image that cannot be edited. However, the PaperPort software has
optical character recognition (OCR) software to process scanned text
when using a Word Processing or Spreadsheet link icon. The OCR
software converts the scanned text image to editable text; it does not
translate photos or graphics. You can process an entire item or only the
text that you select. You have several options for using OCR software
with the PaperPort software, as described in the following procedures.

To use the provided OCR software
1 In Desktop View, select an item.
2 Drag the item onto the Word Processing or Spreadsheet icon on the

Link Bar.
- Or -
Click the Word Processing or Spreadsheet icon.
- Or -
From the File menu, select Links and then select the word processing
or spreadsheet software from the submenu.

The OCR software converts the item to editable text. The word
processing or spreadsheet application opens and the converted text is
displayed as an untitled document.

To process text using another OCR software link
1 In Desktop View, select an item.
2 Drag the item onto that OCR icon on the Link Bar.

- Or -
Click the OCR icon.
- Or -
From the File menu, choose Links and then select the OCR software
from the submenu.

The file is processed by the OCR software and then opens in your
selected word processing or spreadsheet application.
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The PaperPort software can process text with the OCR software and
then place the editable text on the Clipboard. You can paste the text into
another application, such as a word processor.

To process text using the “Copy As Text”
command

1 In Desktop View, select an item.
2 From the Edit menu, choose Copy As Text. The text is now on the

Clipboard and ready to be pasted.

N o t e If you want to process only a portion of a page, display the item in Page
View, on the Annotation Tool Bar, click Edit Annotations, and then
select the portion of text that you want to process.
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Adjusting Copy and Scan Quality

The HP LaserJet Companion Settings utility allows you to control the
quality of the copied and scanned images, including documents copied
by the Direct Copy feature. Perform the following steps before scanning
an item to change the scan mode, brightness, contrast, resolution, and
width of the scanned image.

To change the HP LaserJet Companion Settings
1 Click Settings on the PaperPort screen.

T i p If the Show Tips box is checked, you can see more information about
each button or selection when you hold the cursor over it.

2 Select the Scan Mode. The window under your choices gives a brief
description of which types of documents are best suited for the mode
you have selected.

N o t e If you select Custom mode, Modify, you can change the resolution and
the bit depth to improve image quality. See the “Setting Custom
Resolution and Bit Depth” section later in this chapter for more
information.

3 Drag the Page Width slider or click the arrows to set the width of the
page being scanned. This feature allows you to crop the page before
scanning to reduce extra white space.

4 Drag the Sensitivity slider to adjust the scanner brightness and
contrast. A setting of four reproduces the document’s actual brightness
and contrast. A setting of zero makes the resulting scan darker and
muddier, and a setting of eight is lighter and sharper.

5 Click More to select the length of paper in the printer. This feature tells
the printer when to feed the next sheet of paper.

6 Click Apply to send the settings to the HP LaserJet Companion and
leave the window open.
- Or -
Click OK to send the settings to the HP LaserJet Companion, and close
the window.

N o t e Any settings you choose will remain in effect until you change them.
These settings will also be in effect for the Direct Copy feature.
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Setting Custom Resolution and Bit Depth

If you are using the Custom mode, you can select the resolution and bit
depth of the scan.

To set the resolution and bit depth
1 Click Modify.
2 Select the resolution you want.

• 150 dots per inch (dpi)—Produces a smaller file size and faster scan.
• 300 dpi—Produces a sharp, higher-quality image, and a large file.

3 Select the Bit Depth.
• 1 Bit (black and white) Thresholded—Best for text only or

black-and-white images.
• 1 Bit (black and white) Ordered Dither—Best for text and images.
• 1 Bit (black and white) Random Dither—Best for photos or images,

but without text.
• 4 Bit Grayscale—Best for images only; produces 16 shades of gray.
• 8 Bit Grayscale—Best for images only; produces 256 shades of gray.
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4

Working in the PaperPort Software

General Features

The PaperPort software allows you to find, annotate, and organize
scanned items. You can also electronically link scanned documents to
other applications such as fax, electronic mail (e-mail), and word
processing applications. Unless you specify otherwise, the PaperPort
software is the default inbox for receiving scanned documents at your
computer.

Desktop View and Page View

The PaperPort software has two ways to view scanned material:

• Desktop View provides an overall view of the PaperPort items, shown as
thumbnails (icons representing scanned items). In the PaperPort
software, single-page scanned documents are referred to as items.
Multi-page scanned items are referred to as stacks.

• Page View is a close-up of one page at a time and allows you to read
and annotate the page.
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A Command Bar
B Folders
C Link Bar
D Status Bar

To switch between Desktop View and Page View

• Click Desktop or Page on the Command Bar.
• From the View menu, choose Page View or Desktop View.
• In Desktop View, double-click an item to display that item in Page View.

Figure 4-1
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The Command Bar

The buttons on the Command Bar provide quick access to various
commands on the menus. Some of the buttons are not available in both
views.

Icon Description Icon Description

Desktop—Switches from
Page View to Desktop View.
Available only in Page View.

Duplicate—Makes an
electronic copy of the
selected item. Available only
in Desktop View.

Page—Switches from
Desktop View to Page View.
Available only in Desktop
View.

Stack—Stacks selected
items into one stack.
Available only in Desktop
View.

Scan—Acquires an image
from the selected TWAIN
source.

Unstack—Unstacks the
pages of the selected stack.
Available only in Desktop
View.

Settings—Displays the
Scan Settings dialog box
where you can change the
HP LaserJet Companion’s
settings.

Unstack 1—Unstacks the
current page of the stack.
Available only in Desktop
View.

Find—Finds an item in the
Desktop View; finds
annotations in Page View.

Arrange—Rearranges the
items in Desktop View.

Browse—Shows a list of
items.

OLE Rtn— Switches to the
application you are using
with OLE. Available only
when using an OLE feature.

Rotate—Rotates the
selected item 90 degrees to
the right.
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Setting Preferences

You can customize the PaperPort software so it displays according to
your preferences.

To select preferences
1 From the Edit menu, choose Preferences. The PaperPort Preferences

dialog box appears.
2 Click the Desktop icon.
3 Select the options you want. The options are explained in the following

table.

Option Description

Scan to Desktop As you scan items, they appear on the PaperPort
desktop view as thumbnails.

Scan to Page
View

The scanned items first appear in Page View instead of
Desktop View.

Show Text with
Icons

When this option is selected, the buttons on the
Command Bar have names on them. When this option is
cleared, the buttons will be smaller and will not have any
text on them.

Show Tool Tips Displays short descriptions of the Command Bar buttons
and Annotations.

Color Screen Select this option if your computer has a color monitor;
otherwise clear this option.

Maximize
Window at
Startup

Select this option if you want the PaperPort window to be
maximized (fill the computer screen) when the PaperPort
software starts.

Use Gray Dialog
Background

Select this option to show PaperPort boxes with a gray
instead of a white background. The gray background
color appears the next time you restart Windows.

4 Click OK to save the Desktop Preferences and exit the Preferences
dialog box.

4-4 Working in the PaperPort Software EN

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Automatic Saving

Every item in the PaperPort software is automatically saved as soon as
you scan it. Any changes that you make to an item, such as adding a
note or giving an item a new title, are automatically saved as well.

If you want to delete items from the Desktop but save back-up copies or
save them in some other format, such as .BMP or .TIF, from the File
menu, choose Export. For details, see PaperPort Help.

Giving Titles to Items

The PaperPort software items can have titles of up to 30 characters
long, such as “Smithers Contract” or “Letter to Jones, Ltd.”

The title of an item appears in the following three places in the PaperPort
software:

• At the top of the item in Desktop View
• On the Document Navigator (under the Command Bar) in Page View
• On the Status Bar

To retitle an item in Desktop View
1 Select the item. If you have not titled an item, the PaperPort software

automatically names the item “Untitled.”
2 Click the title. An edit box appears around the title.

- Or -
From the File menu, choose Change Title. An edit box appears around
the title.

3 Type the new title, and press [Enter]. The item will have the new title.

Displaying and Hiding Elements

Display or hide the Folders, Command Bar, Link Bar, Status Bar, or Tool
Palette by selecting each from the View menu. A check mark next to the
menu item indicates the tool bar or folders are visible.

N o t e Not all menu items are available in both views.
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Rotating or Flipping an Item

Rotate a page in 90-degree increments or flip it in 180 degree
increments to change the direction of an image on the page.

To rotate or flip an item
1 Select the page you want to rotate, or display it in Page View.
2 Do any one of the following:
• From the Page menu, choose Rotate Right or Rotate Left to rotate the

item 90 degrees.
• On the Command Bar, choose Rotate Right to rotate the item 90

degrees to the right.
• From the Page menu, choose Flip to rotate the item 180 degrees from

its current position.

N o t e Annotations and pages that have annotations cannot be rotated. To
temporarily remove the annotations and rotate the page, select the
annotations and, from the Edit menu, choose Cut. Then rotate the page.
If you choose Paste, the annotations will be restored but not rotated. For
additional information on exporting files, see PaperPort Help.

Deleting an Item

Deleting an item permanently removes it from your computer. If you want
to save an item, from the File menu choose Export before deleting the
item from the PaperPort software.

To delete an item
1 Select the item in Desktop View, or display the item in Page View.
2 Press [Delete].

- Or -
From the File menu, choose Delete Item.
- Or-
In Desktop View, choose Delete from the Edit menu.

3 Click Yes to delete the item.
- Or -
If you have selected multiple items, click Yes to All to delete all items at
once.
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Undoing an Action

To undo the last action you made in the PaperPort software, from the
Edit menu, choose Undo. For example, if you move a thumbnail on the
Desktop, choose Undo Move, and the thumbnail will move back to its
original location. Similarly, if you highlight a section of text on a page in
Page View, choose Undo Highlight to remove that highlighting.

When you undo an action, the Undo command changes to Redo. Redo
replaces anything you deleted with Undo.

To undo all annotations and other changes made to the item, in Page
View, choose Undo All Changes from the Edit menu.
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Working in Desktop View

Desktop View provides an overall view of PaperPort items and stacks.
Each item in Desktop View is shown as a thumbnail (an icon
representing a scanned item).

Selecting Items

Before performing an action on an item, such as moving it or printing it,
you must select the item. A red (or dark) line around an item indicates
that it is selected.

To select items in Desktop View

• To select a single item, click its thumbnail.
• To select multiple items, click each thumbnail while holding down [Shift]

or [Ctrl].
- Or -
Position the cursor, click the left mouse button, and drag a selection box
around the items you want to select. Release the mouse button to select
the items. Any item partially enclosed or touched by the selection box
will be selected.

• From the Edit menu, select all items by choosing Select All.

T i p To deselect items, reverse the above steps.

Editing Scanned Images

While PaperPort software gives you some editing capabilities, such as
cutting, pasting, and moving items, you will want to see “Editing
Scanned Images using OCR Links” in chapter 3 for instructions on
editing the actual document.
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Moving and Arranging Items

If you would like to organize the items in Desktop View, you can either
move each thumbnail with the mouse or use the PaperPort software’s
Arrange feature.

To move an item, drag it to a new location in the Desktop View.

To arrange all of the items in Desktop View, from the Desktop menu
choose Arrange Desktop, or on the Command Bar, click Arrange. The
thumbnails are automatically arranged in rows on the screen.

If you want only to arrange certain items in Desktop View, select the
items you want to arrange. Then from the Desktop menu, choose
Arrange Selected Items. The selected items will be arranged in rows
after the unselected items.

Duplicating Items

Create a duplicate of a selected item in Desktop View in any of the
following ways:

• From the Desktop menu, choose Duplicate Item.

-or-

• On the Command Bar, click Duplicate.

-or-

• Press [Ctrl] while dragging the item to another location in Desktop View.
The pointer will have a plus (+) sign in it to indicate the selected item will
be duplicated.
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Working with Stacks

In the PaperPort software, a stack is an item with multiple pages. Use
the stack feature to organize multipage documents.

When you use the automatic document feeder to scan a document, the
document will appear as a multipage stack in Desktop View. When you
scan an item, each scanned page appears in Desktop View as a
one-page, untitled item.

To stack items using drag-and-drop
1 In Desktop View, select the item to stack.
2 Place the pointer on the selected item, and press and hold down the left

mouse button.
3 Move the pointer onto the second (target) item so the target item

becomes highlighted, and release the mouse button.

The selected item is stacked on top of the target item. Repeat steps 1
through 3 to stack additional items.

N o t e You can add Summary Information about the stack after creating it.
Summary Information for individual pages that are then stacked is
retained only for the bottom page in the stack. For details, see PaperPort
Help.

To stack items using the Stack Selected Items
command or the Stack button

1 In Desktop View, select the items you want to stack in the order that you
want them to be stacked. The first item selected will be on top.

2 From the Desktop menu, choose Stack Selected Items.
- Or -
Click Stack on the Command Bar.
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Navigating Within a Stack

To move between pages in a stack, select the stack and click the arrows
on the scroll bar (Page Navigator) below the stack. To move to a specific
page in a stack, click the middle of the Page Navigator scroll bar to bring
up the Go To Page dialog box or choose Go To Page from the Page
menu. Then enter the page number.

Unstacking Pages

Unstack pages to move pages to another stack, replace pages with new
ones, or delete pages from the stack without disturbing the rest of the
pages.

N o t e You do not need to unstack pages to add annotations. Double-click a
stack to display it in Page View, where you can see and annotate the
pages one page at a time.

To unstack a single page from a stack
1 In Desktop View, select the stack.
2 Use the Page Navigator to display the page you want to unstack.
3 From the Desktop menu, choose Unstack Current Page.

- Or -
Click Unstack 1.

The PaperPort software unstacks the selected page and displays it as a
new, untitled item.

To unstack a whole stack
1 In Desktop View, select the stack.
2 From the Desktop menu, choose Unstack.

- Or -
Click Unstack on the Command Bar.

The PaperPort software unstacks the pages, and shows all of the pages
as selected, untitled items in Desktop View.

N o t e Any Summary Information for a stack is lost during the unstacking.
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Reordering Pages in a Stack

After creating a stack, you can reorder the pages.

To reorder the pages in a stack
1 In Desktop View, select the stack.
2 From the Desktop menu, choose Reorder. A dialog box displays the

current order of the pages in the stack. If the page you want to reorder is
not visible, use the horizontal scroll bar.

3 Select the page you want to move.
4 Drag the page to its new location. A vertical line shows the new location

of the page.
5 Click OK to close the dialog box. The pages reorder automatically.

Inserting a Page in a Stack

Both the page you want to insert and the target stack must be displayed
in Desktop View.

To insert a page in an existing stack
1 In Desktop View, select the target stack.
2 Use the Page Navigator to move to the location where you want to insert

the new page.

N o t e The new page will be inserted on top of the current page.

3 Select the page you want to insert and drag it onto the target stack. The
PaperPort software places the page at the new location.

Alternatively, you can drag a page onto the stack and reorder the pages
using Reorder. For more information on using the Reorder command,
see “Reordering Pages in a Stack” earlier in this section.

T i p You can insert a new page into a stack as a section separator. To create
a new, blank page in the PaperPort software, choose New Item from the
File menu. The PaperPort software displays a new untitled item. You can
then insert it into the stack.
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To copy a page in a stack
1 In Desktop View, select the stack.
2 Use the Page Navigator to move the page you want to copy to the top of

the stack.
3 From the Desktop menu, choose Duplicate Current Page. A duplicate

of the selected item appears as a new, untitled item in Desktop View.

Adding Summary Information to Items

You can add summary information to items to help you find them quickly.

N o t e If you’re going to combine items into a stack, add the summary
information after stacking the pages. If you add summary information to
individual items and then stack those items, the summary information
will be lost.

To add summary information to an item
1 Select an item or display the item in Page View.
2 From the File menu, choose Summary Info.
3 Enter the summary information in the Summary Information dialog box.

The fields are described in the following table.

Field Description

Title The field will be blank if the item is “Untitled.” Changing the title
here also changes it in Desktop View.

Creator Type your name.

Keywords Words the PaperPort software uses to find items. Separate
keywords with a comma. During a search, tell the PaperPort
software which keywords to find, and the PaperPort software finds
items with keywords that match any that you specify.

Comments Add any additional information about the items. The PaperPort
software can also use these comments to search for and find items.

4 Click OK. Summary information is attached to the item and will appear in
the Summary Information dialog box.
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Working in Page View

Page View displays an item one page at a time and allows you to read
and add annotations to a page. Use the Navigators to display other
pages of a stack, see other items, or enlarge the image.

A Zoom Navigator—Click the “minus” and “plus” magnifying glasses to
reduce or enlarge the image. Click Actual to return the image to its
actual size. The scale of the image is shown on the right side of the
Status Bar.

B Page Navigator—Click the arrows to scroll between pages in the stack.
Click between the arrows to activate the Go To Page feature.

C Document Navigator—Click the arrows to scroll among the items in the
PaperPort software. Click between the arrows to see a list of the items in
the PaperPort software.

D Annotation Tool Bar—Use these tools to add notes, highlight areas, or
cut and paste selections. For more information on using the Annotation
Tools, see chapter 4, “Annotating Scanned Items.”

E Status Bar—Use to view information about the current item: the title, the
dots per inch at which the item was scanned (resolution), whether the
image is color or black and white, and the percentage of enlargement or
reduction of the page.

Figure 4-2
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Changing the Display Size of an Item

Use the Zoom Navigator or Zoom commands from the View menu to
zoom in and display the details of a page, or zoom out and make the
page smaller on the screen while in Page View. The page magnification
is shown in the status bar in Page View. Use any of the following
methods to change the display size:

• From the View menu, choose Zoom In or Zoom Out.
• Click the plus (+) or minus (-) magnifying glass on the Zoom Navigator.
• From the View menu, choose Actual Size or click Actual Size on the

Zoom Navigator to view the page at its actual size (100%).
• From the View menu, choose Fit to Window to enlarge or reduce an

item to fit the entire item into the Page View window.

Panning an Item

Panning an item is a quick way to scroll through an item in Page View
when the entire item is not visible on the screen.

To pan an item
1 Display the item in Page View.
2 Click Pan on the Annotation Tool Bar.
3 Place the pointer on the item. The pointer changes to a hand.
4 Press the mouse button and drag up, down, right, or left. The area of the

page you are viewing changes as you drag the pointer.

The Pan tool remains active until you deselect it or view a different item.

Inverting an Image

This feature allows you to change an item from black-on-white to
white-on-black.

To invert an image
1 Display the item in Page View.
2 Choose Invert from the Page menu. The image is reversed from

black-on-white to white-on-black. Gray shades are reversed as well.

Repeat these steps to change the image back to its original appearance.
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The PaperPort Viewer

You can share PaperPort items, including contracts, budgets, reports,
and letters, with others who do not own PaperPort software. With
PaperPort Viewer, others can view and print PaperPort items.

Obtaining Copies of the PaperPort Viewer

PaperPort Viewers are available for free on CompuServe and on the
Internet. Users can log on to CompuServe and retrieve the PaperPort
Viewer file. To download the files, type GoPaperPort in the Office
Automation Forum. The PaperPort Viewer is available on the Internet at
URL http://www.visioneer.com.
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5

Troubleshooting and Maintenance

Check Here First

Before proceeding, check the items listed below. If you cannot resolve a
problem, contact HP FIRST for assistance. Phone numbers are listed on
the support pages at the front of this manual.

• Is the power supply connected to the HP LaserJet Companion and
plugged into an electrical outlet?

• Is the HP LaserJet 6L Printer plugged into an electrical outlet?
• Did you try unplugging the HP LaserJet Printer and Companion from the

electrical outlet, then plugging them back in?
• Is the interface cable from the HP LaserJet Companion to the computer

connected?
• Is the parallel cable from the HP LaserJet Companion to the printer

connected?
• Are you using an IEEE-1284 compliant parallel cable? (“IEEE-1284” will

be stamped on the cable.)
• Are you having problems with installation? (If so, check the section on

solving installation problems.)
• Are the Printer and the Companion free of paper jams? (If not, see their

respective sections on clearing paper jams later in this chapter.)
• Are the Front Panel indicator lights on your printer indicating a problem?

(If so, check the section on Printer Messages later in this chapter.)
• Are there any messages displayed on your computer? (If so, check the

section on error messages later in this chapter.)
• Are you experiencing poor print quality? (If so, see the section on

Solving Print Quality problems.)
• Are you unable to scan?  (If so, see the section titled “HP LaserJet

Companion Operation Problems.”)

For more information on setup and installation, see chapter one. If you
have questions that you do not find the answers to in this chapter, see
the HP service and support information in appendix B, “Warranty and
Support Information.”

C a u t i o n The HP LaserJet Companion is not compatible with hardware security
keys installed on the parallel port. These security keys are typically used
with high-end design and architectural applications.
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HP LaserJet 6L Printer Operation
Problems

Printing a Self-Test Page

A self-test page can be useful in identifying your printer’s configuration
and to ensure that your printer is working properly.

To print a self-test page
1 Make sure that the Ready light is on and all other lights are off. If

necessary, wake up the printer by briefly pressing and releasing the
Front Panel button.

2 Now briefly press and release the Front Panel button again. The Data
light comes on and the Ready light blinks. Please wait for a self-test
page to print.

If the self-test page does not print, try the following:

1 Ensure that paper is loaded in the printer.
2 Check the printer’s Front Panel Indicator lights to determine the status of

your printer. Then, refer to “Printer Messages” later in this chapter.
3 Contact Customer Support for assistance (refer to the support pages at

the front of this manual for support options).
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Clearing Paper Jams from Your Printer

Occasionally, paper can become jammed
while printing. The following list shows
some possible causes:

• The paper was loaded improperly.
• The Paper Path Lever was adjusted

while a job was printing.
• The Printer Door was opened while a

job was printing.
• The paper being used does not meet

HP’s specifications.
• The paper being used was smaller

than 76.2 x 127 mm (3 x 5 inches).

To clear a paper jam

C a u t i o n
Do not touch the black sponge roller
inside your printer. Touching it may
reduce the print quality on your media.

1 Open the Printer Door and remove
the toner cartridge. Be sure to protect
the toner cartridge from light while
you work on the printer.

2 Press the Paper Release Lever.
3 If your paper jam is in the printer’s

input area, reach inside the printer
and carefully pull the sheet toward
you.

4 If your paper jam is in the printer’s
output area, grasp the sheet and
carefully pull it upward.

5 After removing all sheets and
fragments of paper, replace the toner
cartridge and close the Printer Door.

The printer should return to a Ready state
as soon as you reload the paper.
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Paper Will Not Feed into the Printer

If the print media does not feed into your
printer, briefly press and release the Front
Panel button. The printer will again
attempt to feed the media. If this is
unsuccessful, try the following procedure:

1 Remove the print media from the
Paper Input Bin, realign the media,
and reload it into the printer.

N o t e
Be sure to center print media with the
paper guides. Also, verify that the guides
are not adjusted too tightly or too loosely
against the media.

2 Open the Printer Door.
3 Remove the toner cartridge, making

sure you protect it from light, and
check for a paper jam.

4 Replace the toner cartridge and close
the door.

The printer will automatically resume
printing.
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Printer Messages

If you are having problems with your printer, check the Front Panel
Indicator lights. Determine their status, then use the following table to
help pinpoint and solve printer problems.

Symptom Possible Cause Recommended Action

The printer isn’t
responding after “print” is
selected in the software.

The printer may be paused. Resume printing from the status window or Print Manager.

The printer may be in Manual
Feed mode (Data light
blinking).

Press and release the Front Panel button or the Status
Window Resume button.

The parallel cable between
the printer and the
Companion is not connected
properly.

Disconnect and reconnect the parallel cable between the
printer and the Companion.

The parallel cable is defective. If possible, attach your cable to another system and print
a job that you know works. You may also try using a
different parallel cable (IEEE-1284).

The wrong printer was
selected in your software.

Check your software’s printer selection menu to see if you
selected the HP LaserJet 6L printer.

The software for your printer
is not configured for the
correct printer port.

Check your software’s printer selection menu to make
sure it is accessing the correct printer port.
If your computer has more than one parallel port, make
sure the parallel cable is connected to the correct one.

The power cord is not
connected to the printer or
the power source is not active.

Check the power cord connection and the power source.
Try a different outlet.

The printer is malfunctioning. If all the lights are on, the printer may be signaling a
hardware error. See “All the printer’s lights are on” on the
following page.

The Error (top) light
stays on.

The printer is out of print
media.

Add paper or other print media.

The printer door is open. Close the door securely.

The toner cartridge is not
installed completely.

Open the door, reinstall the toner cartridge, then close the
door securely.

Paper is jammed in the
printer.

See “Clearing Paper Jams” earlier in this chapter.

The Error (top) light is
blinking.

The page is too complex for
the printer’s memory
capacity, or the printer may
not be able to create the
image fast enough to keep
pace with the printing
process.

Briefly press and release the Front Panel button to
resume printing. Some data loss may occur.

See your printer driver Help for suggestions regarding
printer memory usage.

Change your page to make it less complex by reducing
resolution to 300 dpi, or add optional printer memory (see
chapter 1).

Both the Data (middle) light
and the Ready (bottom)
light are on steadily (not
blinking).

Unprinted data is in the
printer. (Your software did not
send an “end of job” or “form
feed” command.)

Briefly press and release the Front Panel button to print
the rest of the data.

The Data (middle) light is
blinking.

The printer is in Manual Feed
mode.

Make sure the correct paper is loaded into the printer.
Briefly press and release the Front Panel button to
resume printing.
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Symptom Possible Cause Recommended Action

All the printer’s lights are
off and the printer does not
respond after attempts to
wake it up.

The printer is unplugged from
the power source.

The printer has
malfunctioned.

Check the power cord connections and power source. Try
a different outlet.

Refer to the support pages on the inside front cover for
support options.

All the printer’s lights are
on.

The printer has a hardware
error.

Disconnect the printer from the power source for 10
seconds, then reconnect it. If the lights remain on,
disconnect the printer from its power source again, this
time reconnecting after a 15-minute wait. If all three lights
come back on again, contact your HP authorized service
representative.

If you have added a memory card to your printer, remove
it and check the indicator lights. See chapter 1 for
installing and removing printer memory cards (DRAM).

All Front Panel lights
remain on when printing
from the spreadsheet
software.

The printer driver settings
may need to be adjusted.

In your printer driver settings, select the Print Quality tab,
then select Manual Settings. Click Settings, then
choose HPGL/2 under the Graphics mode (PCL driver
only).

All three printer lights are
flashing simultaneously.

An incompatible memory
card has been installed.

Remove the incompatible memory card and replace it
with a 1-, 2-, 4-, or 8-MB, 70ns or faster (such as 50ns)
memory card. See chapter 1 for information on installing
memory cards (DRAM).

The printer is feeding
multiple sheets or jams
frequently.

Paper guides are not
adjusted properly.

Remove the paper from the Paper Input Bin or the
Single-Sheet Input Slot. Tap the sides of the paper stack
together, then reinsert the stack. Or reinsert the single
sheet into the slot. Slide the paper guides against the
sides of the stack in the Paper Input Bin or against the
single sheet in the Single-Sheet Input Slot to center the
paper. Make sure the guides are not adjusted too tightly.

The Paper Input Bin is too full. Remove some of the sheets. The Paper Input Bin can
hold up to 100 sheets of 75g/m2 (20-pound) bond weight
paper (less for heavier paper) or up to 10 envelopes (no
more than 7 envelopes for areas with climates having
high humidity).

More than one sheet was
added into the Single-Sheet
Input Slot.

Add only one sheet at a time into the Single-Sheet Input
Slot. If printing more than one sheet of the same type of
media, use the Paper Input Bin.

The paper was poorly cut by
the manufacturer and is
sticking together.

“Break” the ream of paper by curving it into an
upside-down u-shape; this may effectively decrease
multi-feeds. You may also try turning the paper around to
feed the opposite end first.

The paper does not meet
HP’s specifications for print
media.

Order HP’s paper specification guide. To order, see
appendix A, “Accessories and Supplies Information.”

The output capacity was
exceeded in the Paper Output
Bin or Front Output Slot.

Do not allow more than 100 sheets of 75g/m2 (20-pound)
bond weight paper (less for heavier paper) to fill the
Paper Output Bin. Do not allow more than one
transparency or 20 sheets of other media to stack up in
front of the Front Output Slot.

Printer is printing too
slowly (PCL driver only).

The page may be too
complex for the printer’s
memory capacity.

In your printer software, select the Print Quality tab, then
select Manual Settings. Click Settings, then choose
HPGL/2 under the Graphics mode.
Select 300 DPI under the Print Quality tab in your printer
software.

Window message reads:
“Out of memory, unable to
print” (Host-based only).

The page may be too
complex for the printer’s
memory capacity.

Run HPWPRS.EXE in the directory C:\windows. Then,
reboot.
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Symptom Possible Cause Recommended Action

Printer is not responding;
the system is locked up.

The page is too complex for
the printer’s memory capacity.

Free up disk space on your computer or defragment the
drive.
Enable “Print Manager in Windows 3.1x systems” on your
PC.
Run fewer software programs at the same time on your
PC.
Do not perform I/O or processor-intensive tasks on your
PC while printing (e.g., sending a fax or playing a video).

Window message reads:
“No Toner or Door Open.”

The toner cartridge is not
installed completely.

The printer door is open.

On the all the toner cartridge, then close the door
securely.

Close the door securely.

Reset the printer by unplugging the power cord and then
plugging it back into the electrical outlet.
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HP LaserJet Companion Operation
Problems

Scanner Will Not Scan

If the HP LaserJet Companion is unable to scan, try the following:

• Ensure that the interface cable that was shipped with your HP LaserJet
Companion is connected to your computer’s parallel port and to the To
PC connector on the HP LaserJet Companion.

• Unplug the HP LaserJet Companion’s power supply from the surge
protector and then plug it back in. You should hear a brief hum when
you first plug it in. The HP LaserJet Companion does not have a power
button or power indicator light; it is ready to scan when the power is
connected.

• Ensure the parallel port is configured correctly. The parallel port mode is
stored in your computer’s CMOS memory and is accessible through the
computer’s Setup program. This program, which allows you to change
your computer’s CMOS settings, is activated on most computers by
pressing a key such as [F2], [F8], or [Delete] when your computer is
first powering on, but before Windows starts. As your computer is
powering on, watch the screen for a message that gives the correct key
to press to start the program. The message will likely read Press
<Key> for Setup . Once the program is running, locate the section
listing the mode of your computer’s parallel port and make sure it is set
to bidirectional, ECP, Enhanced, or PS/2. The parallel port should not be
set to EPP, AT, or Standard. You can usually change the settings by
scrolling using the [+] or [–] keys, arrow keys, or function keys.

N o t e If you have problems locating or changing the setting, please refer to
your computer’s documentation on changing CMOS settings or to the
Guide to Changing the Parallel Port Mode in Setup included with your
HP LaserJet Companion.

• The HP LaserJet Companion requires a bidirectional or ECP compliant
parallel port to communicate properly with your computer. Older
computers may not have this type of port. If you have another parallel
port on your computer, try attaching the interface cable to that port. You
can also purchase a bidirectional or ECP compliant port and install it on
your computer.
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• If you still encounter communication problems after verifying that the
parallel port is configured for bidirectional communication, there might
be a conflict with other software your computer. Because the HP
LaserJet Companion shares the parallel port with printers and other
devices, software that uses these devices must occasionally release the
parallel port to allow other programs to use the port. If a program that
uses the parallel port does not release it, then the HP LaserJet
Companion software will be unable to communicate with the HP
LaserJet Companion. Printer drivers and printer status monitors are
automatically loaded by Windows at startup, and are often the cause of
such conflicts. The README.TXT, which shipped with the HP LaserJet
Companion, contains a list of software known to cause conflicts. For
instructions on disabling conflicting software, see the HP LaserJet
Companion README.TXT file located in the PaperPort Program group.

Scanner Stops in the Middle of Scanning

The maximum scannable page length is 30 inches (76.2 cm). If the page
is longer, scanning will stop at 30 inches (76.2 cm). Do not try to pull the
page out because you may damage the HP LaserJet Companion. Press
[To[PC] to restart, and the rest of the page will be on a second page in
the PaperPort software.

If you start or restart your computer while trying to make a direct copy,
the scan will be interrupted. Reset the HP LaserJet Companion by first
pressing [Form[Feed] on your printer. Then clear the paper jam as
described in “Clearing Paper Jams from the HP LaserJet Companion” on
the next page. Once the paper jam is cleared, you can, rescan the item.
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Clearing Paper Jams from the HP LaserJet
Companion

The HP LaserJet Companion will not
automatically stop when a page
misfeeds or jams.

To remove paper
1 Press [To[PC] or [To[Printer] during

a scan to stop the scan. If scanning
more than one page, remove any
additional pages from the paper
tray.

2 Pull forward on the release levers
and pull the cover forward.

3 With the cover open, push up and
hold the paper-jam release lever on
the back of the HP LaserJet
Companion while pulling the
document out.

4 Release the paper release lever. It
will automatically reset.

5 Close the front cover, making sure
that both release levers latch.
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Companion Error Messages

When a problem occurs, an error message may be displayed on your
computer. This section explains what to do if you see one of these
messages.

Symptom Category Recommended Action
An unsuccessful application exit has left
Windows in an unstable state. You should
restart Windows.

General This can occur if your computer “hangs” or “crashes” while
the PaperPort software is running, or if some other error
occurs. Try restarting Windows. Although you can continue
to work in Windows, you will not be able to scan or start the
PaperPort software again until you restart Windows.

COMMUNICATION PROBLEM
Error Code: XXX

General The software has failed to communicate with the HP
LaserJet Companion. Repeat the software action that
generated the message. If the message occurs again,
unplug the HP LaserJet Companion from its power source
and plug it back in. If the message reoccurs, your
computer’s CMOS may not be configured for bidirectional
parallel port communication. For more information on
configuring your CMOS, see the “HP LaserJet Companion
Operation Problems” section earlier in this chapter or the
Guide to Changing the Parallel Port Mode in Setup included
with your HP LaserJet Companion.

Not enough disk space. Memory The PaperPort software requires at least 8 MB of available
disk space to be installed. After you select the PaperPort
software and data directories, the installation program
checks that your computer has enough available disk
space. If you need more disk space, try deleting
unnecessary files or archiving older data to floppy disks or
some other medium.

One or more pixels could not be gain
corrected. The remaining pixels were
calibrated. You will likely see vertical
streaks in scanned images.

General The recalibration detected a non-correctable dark line. This
could be caused by using lined paper for recalibration, or a
contaminant may be obstructing the scanning element. Be
sure to use clean white paper for recalibration. For cleaning
instructions, see “Cleaning the HP LaserJet Companion”
earlier in this chapter.

PaperPort cannot arrange your Desktop
because system resources are low. Please
close one or more applications and try
again.

Desktop Quit any other applications that are running. If there are any
items in your Startup program group, remove them, restart
Windows, and try again. Note that some applications do not
release all the memory or resources that they use even
when you exit them. Restarting Windows with no
applications in your Startup group can give you maximum
memory and resources.

PaperPort cannot create a calibration file.
Your disk may be full or read-only.

General Make sure that your hard disk is not full. The calibration file
requires up to 100K of hard disk space. (Note that you
should have at least 1 MB of free hard disk space to use
the PaperPort software.) In addition, check that you have
read/write access to the drive containing the PaperPort
program directory.

PaperPort cannot paste because the
clipboard image is larger than the current
page.

General The image that you have cut or copied to the Clipboard is
larger than the item on which you are trying to paste. Try
copying a smaller image to the Clipboard. If you have a
large image to paste, divide it into sections and copy and
paste each section in turn. When pasting to a PaperPort
item, the PaperPort software enables you to position the
paste precisely before committing it.

PaperPort cannot read page <N> of the file
<file name> because the page is damaged.

Disk and File An item or a page in a stack can be damaged if your
computer is shut down while the PaperPort software is
running or if the PaperPort software is shut down in any
way other than by a normal exit. Attempt to repair this file by
running MAXFIX.EXE. Follow the instructions on the
screen.
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Symptom Category Recommended Action
PaperPort is out of available system
memory. Please close some other
application(s) and select Retry to proceed,
or select Cancel to close PaperPort.

There is not enough available memory to
complete this operation. Please see
PaperPort Help or the Troubleshooting
section of your User’s Guide.

Memory These errors can be caused by low memory, insufficient
system resources, or too few file handles. You should have
at least 8 MB of available memory and 50% of your system
resources. Note that your computer should have 8 MB of
physical RAM (not virtual memory) to use the OCR link.

To make more memory, resources, or file handles available,
try the following:

PaperPort cannot receive printed pages.
System memory may be low. Try exiting
from other applications.

• Create a permanent swap file in the Virtual Memory
section of the 386 Enhanced Control Panel. Use the size
suggested in the dialog box. Make sure you have at least
20 MB of available space on the selected drive.

• Quit any other applications that are running. If there are
any items in your Startup program group, remove them
and restart Windows.

• If you are using a computer with less than 6 MB of
physical memory, limit the SmartDrive cache for Windows
to 256K or 128K. To do this, edit your AUTOEXEC.BAT
file. Change the second number in the line
DEVICE=CKSMARTDRV.EXEto 256 or 128 .

• Before Windows starts, check the amount of memory
available by typing MEMat the DOS prompt. The largest
executable program size should be at least 450K. If it
isn’t, see your DOS and Windows documentation for
information about optimizing memory.

• Try increasing by 20 the line FILES= in your
CONFIG.SYS file to increase the number of file handles.
Restart your computer.

PaperPort cannot use the file <file name>
because it is damaged.

Disk and File An item or a page in a stack can be damaged if your
computer is shut down while the PaperPort software is
running or if the PaperPort software is shut down in any
way other than by a normal exit. Attempt to repair this file by
running MAXFIX.EXE. Follow the instructions on the
screen.

PaperPort cannot use the link <link name>
because it is either damaged or
incompatible with the current software
version.

Link Try reinstalling the linked application. If the problem
persists, contact HP to see if an update is available for the
link.

PaperPort has detected that the support
file MAXLINK.DLL has been overwritten by
a recently installed link. Please install
PaperPort again to install the correct
MAXLINK.DLL.

Link If you install a supported linked application that has an
older version of MAXLINK.DLL, it may overwrite the newer
version in the PaperPort directory. Reinstall the PaperPort
software and the correct version of this file will be properly
installed.

PaperPort is busy and cannot be closed
right now. Please wait until the current
operation has finished, or close all
PaperPort dialog boxes and try again.

General The PaperPort software is busy processing. Wait one or
more minutes, and then try quitting the PaperPort software
again.

PaperPort is currently busy and cannot
accept the printed item. Please close any
open PaperPort dialog boxes before trying
again.

General Close any open PaperPort software dialog boxes and try
again.

PaperPort is currently busy and cannot
complete this operation. Please close any
open PaperPort dialog boxes before trying
again.

General Close any open PaperPort software dialog boxes and try
again.

Please specify the name of your Fax
software before using the Fax link.

Link You must select the fax software driver by choosing
Preferences from the Edit menu, and under Category,
select the Fax or generic fax icon.
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Symptom Category Recommended Action
The Desktop file is either damaged or
missing. PaperPort will continue with a new
Desktop.

Desktop The desktop file contains information you need for
accessing the items on the Desktop. If this file is damaged,
you may be able to fix it with the MAXFIX utility. Run
MAXFIX.EXE and then follow the instructions on the screen.

The desktop file can be damaged if your computer is shut
down while the PaperPort software is running or if the
PaperPort software is shut down in any way other than by a
normal exit. If the PaperPort software can restore the
desktop file, it will continue normally. Otherwise, see the
support pages at the front of this manual for support
options.

The image data being unpacked is
damaged.

General If you get this message while scanning, try scanning the
item again. If you get this message while importing a file,
the file may be damaged or there may be a disk error. You
can run a disk diagnostic utility to investigate this or run
MAXFIX.EXE. Follow the instructions on the screen.

The calibration of exposure time failed. The HP LaserJet Companion has failed a critical step in the
recalibration process. Repeat the recalibration process. See
“Recalibrating the HP LaserJet Companion” later in this
chapter. If the message occurs again, the HP LaserJet
Companion has failed and requires repair or replacement.
See appendix B, “Warranty and Support Information.”

The system is too busy to accept a page
from your scanner. Please scan this page
again.

General Your computer was busy doing something else, so the HP
LaserJet Companion could not communicate with the
PaperPort software. In most cases, scanning again will
succeed. If not, quit other applications and try scanning
again.

This item contains one or more
annotations that cannot be displayed by
this version of PaperPort.

General The item contains one or more annotations created by a
later version of the PaperPort software than the one you are
using. You can view all the annotations by upgrading your
version of the PaperPort software. To upgrade, contact HP
Customer Support (see appendix B).

Too many files were found. Please enter a
different starting directory or file name and
try the search again.

General The PaperPort software found more files than it can display.
Enter a different search criteria that will limit the search to a
smaller number of files.

Your OCR software was not able to
process the selected pages.

Link This error can be caused by a low-memory condition or a
problem with the OCR software. For more information about
making more memory available, see the memory
messages in this chapter.
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HP LaserJet 6L Printer and
Companion Installation Problems

If you are having installation problems, check the following table. Also,
you can refer to online help by selecting Help on your menu bar.

Symptom Recommended Action

Window message during
installation reads: “File in Use.”

Quit all software.
Remove all software from the Startup group and then restart
Windows. Reinstall the printer drivers.

Cannot install the printer drivers. Try the Alternative Installation as described in chapter 1.

Bidirectional communication
between printer and computer has
not been established during
installation.

The cable is not bidirectional. Use only a high-quality IEEE-1284
compliant parallel cable.
The cable is loose, or not directly connected.
In Windows 3.1x, open the Control Panel and Printers. Select
HP LaserJet 6L and click Connect. Be sure that the correct
port has been selected and that “Fast Printing Direct to Port” is
check.
Note: If any of the above apply, choose skip and continue
installation.

Your computer cannot read the
installation disks.

Check for the proper floppy drive (e.g., A: or B:).
Check the disks for damage.
Copy disks to the hard drive; then install from your hard drive.

Windows fails to restart. If Windows fails to restart when you choose Restart Windows
at the end of the installation, the installation has not been
successful and the PaperPort software will not work. This
includes cases in which the system “hangs” or “freezes” or exits
to DOS. Reboot your computer, and then try running the
installation program again. If the problem occurs again, quit
Windows. At the DOS prompt, change to the Windows System
directory by typing CD C:\WINDOWS, and press [Enter]. Type
PPUPDATE, and press [Enter]. This completes the installation.
Note: The PaperPort software does not support Windows NT,
OS/2, or Windows running under OS/2 (Win-OS/2).

During installation, you get the
message “HP LaserJet 6L printer
has not been found.”

Check the power cord connections and power source.
Make sure you are using a high-quality IEEE-1284 compliant
parallel cable.
If, after checking these items, you still see the
“HP LaserJet 6L printer has not been found” message, click
Continue to proceed with the PCL driver installation.
If the installation could not be successfully completed, see the
Alternative Installation instructions in chapter 1.
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Solving HP LaserJet 6L Print Quality
Problems

Use the following table to help pinpoint and solve print quality problems.

Symptom Possible Cause Recommended Action

Print is faded or
you notice a
block of
vertically aligned
white streaks.

The toner cartridge may be getting low
on toner.

The paper you are using may not meet
HP’s paper specifications (for example, it
may be too moist or too rough).

Toner density setting may need to be
adjusted.

EconoMode may be on.

See chapter 2, “Managing HP LaserJet
Toner Cartridges.”

Order HP’s paper specification guide
listed in “Accessories and Supplies
Information” in appendix B.

Adjust the setting through your software
or printer driver.

Turn EconoMode off through your
software or printer driver.

Stains or
smudges appear
as small, round,
black dots on the
front or back of a
page. Sometimes
inconsistent
stains appear.

The paper you are using may not meet
HP’s paper specifications (for example, it
may be too moist or too rough).

You may be printing on the wrong side of
the paper.

The printer may need cleaning.

The toner cartridge may be damaged.

Order HP’s paper specification guide
listed in “Accessories and Supplies
Information” in appendix A.

Remove the paper from the Paper Input
Bin and turn it over. (The wrapper on
many reams of paper has an arrow
indicating the print side.)

See “Cleaning Your Printer” in this
chapter.

Replace it if maintenance procedures do
not improve print quality. See chapter 2,
“Managing HP LaserJet Toner
Cartridges.”

Vertically-aligned
black streaks or
smears appear
on successive
pages.

The toner cartridge may be damaged.

The printer may need cleaning.

Replace it if maintenance procedures do
not improve print quality. See chapter 2,
“Managing HP LaserJet Toner
Cartridges.”

See “Cleaning Your Printer” in this
chapter.
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Symptom Possible Cause Recommended Action

Horizontally
aligned black
streaks or
smears appear.

The toner cartridge may not be installed
properly.

The toner cartridge may be defective and
need replacing.

Printer may need repair.

Remove the cartridge and reinsert it. See
chapter 1, “Installing the HP LaserJet
Toner Cartridge” for installation
information.

The toner cartridge may still be under
warranty. See “HP LaserJet Toner
Cartridge Warranty” in appendix B.

See the support pages at the front of this
manual for support options.

Light character
shadows or
repetitive marks
appear on the
page.

The printer may need cleaning.

If you are using transparencies, they may
not meet HP’s specifications.

The paper’s texture may be too coarse.

The toner cartridge may be damaged,
causing a repetitive black flaw on every
printout.

The toner cartridge’s photosensitive
drum may have been overexposed to
bright light, causing repetitive defects
(usually a fuzzy black area).

See “Cleaning Your Printer” in this chapter.

For ordering information, see
“Accessories and Supplies Information”
in appendix B.

Try changing to a paper with a smoother
finish.

Replace the toner cartridge. See
“Accessories and Supplies Information”
in appendix B.

Replace the toner cartridge. See
“Accessories and Supplies Information”
in appendix B.

Vertical white
stripes appear
on the page.

The printer’s internal mirror is
contaminated.

Contact an authorized HP service
representative to replace the printer’s
internal mirror. See the support pages at
the front of this manual for support
options.

Character voids
appear (white
areas within the
parts of
characters that
should be solid
black).

If you are using transparencies, they may
not meet HP’s specifications.

You may be printing on the wrong
surface of the paper.

The paper may not meet HP’s
specifications.

HP’s LaserJet transparencies are
designed to minimize character voids.
For ordering information, see
“Accessories and Supplies Information”
in appendix B.

Remove the paper and turn it around.
(The wrapper on many reams of paper
has an arrow indicating the print side.)

Order HP’s paper specification guide
listed in “Accessories and Supplies
Information” in appendix B.
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Symptom Possible Cause Recommended Action

Background
scatter appears
on a printed
page.

Background scatter results from bits of
toner distributed on the front or back of a
printed page. Background scatter often is
isolated to a specific area of the page.

Change the paper type, weight, or
surface finish. To order HP’s paper
specification guide, see “Accessories
and Supplies Information” in appendix B.
If background scatter occurs on an
envelope, try moving the text to an area
with no seams. Printing on seams can
cause this problem.

If this problem occurs on the back of a
printed page, it may be caused by spilled
toner inside the printer. See “Cleaning
Your Printer” in this chapter.

The page is
completely black.

The toner cartridge may not be installed
properly.

The toner cartridge may be defective and
need replacing.

The printer may need to be repaired if
the problem continues after replacing the
toner cartridge.

Remove the cartridge and reinstall it. See
“Installing the HP LaserJet Toner
Cartridge” in chapter 1.

The toner cartridge may still be under
warranty. See “HP LaserJet Toner
Cartridge Warranty” in appendix B.

See the support pages at the front of this
manual for support options.

Characters are
only partially
printed (also
referred to as
dropouts).

A single sheet of paper may be defective.

The print density may need adjusting.

The moisture content of the paper may
be inconsistent or the paper may have
moist or wet spots on the surface.

The paper may have been damaged by
inconsistent manufacturing processes.

Try reprinting the job.

Adjust the print density through your
software or printer driver.

Use paper from a fresh ream or a
different source. To order HP’s paper
specification guide, see “Accessories
and Supplies Information” in appendix B.

Try using paper from a different source.
To order HP’s paper specification guide,
see “Accessories and Supplies
Information” in appendix B.
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Symptom Possible Cause Recommended Action

The bottom of
the page is blank
or part of a
graphic’s image
is cut off.

Your page may be too complex for the
standard printer memory.

Set the resolution to 300 dpi through
your software or printer driver.

You may need to install additional
memory. See chapter 1, “Installing
Memory Cards (DRAM).”

Check your printer driver’s online help for
suggestions that are specific to your
driver’s settings.

Pages are
coming out of
the printer curled
or wrinkled.

Paper is curled or wrinkled when using
the Paper Output Bin.

Paper may not be stored properly.

Use the Front Output Slot by pushing the
Paper Path Lever to the lower position.
This provides the straightest paper path.
See “Selecting the Output Paper Path” in
chapter 2.

Use the Paper Input Support located
behind the Paper Input Bin. See “Loading
the Paper into the Printer” in chapter 1.

Whenever possible, store paper in its
sealed ream at room temperature.

Blank Page
(Occasional)

Page length and margins are not set
correctly for the paper size.

Some sharing devices or networks may
generate a blank page as a separator
(contact your Network Administrator).

Your printer may be feeding two or more
sheets of paper at a time because the
paper is difficult to separate.

Your software application may be
sending an extra page-eject command.

If you are printing on small paper and
your page is blank, try printing on larger
paper to see where the image is printing.
Adjust the margins accordingly.

If you are on a network, try connecting
the printer directly to the computer.

Remove the paper from the Paper Input
Bin and align the edges of the paper.
“Break” the ream of paper by curving it
into an upside-down u-shape; this may
effectively decrease multi-feeds. You may
also try turning the paper around to feed
the opposite end first.

Check your software’s printing
configuration information. If you are using
a word-processing program, check for a
natural page break and a forced page
break that are close to each other.
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Symptom Possible Cause Recommended Action

Blank Pages
(All Pages)

The toner cartridge may be improperly
installed.

The toner cartridge may be completely
out of toner.

The printer may need to be serviced.

Make sure you removed the entire length
of the sealing tape from the toner
cartridge before you installed it. See
“Installing the HP LaserJet Toner
Cartridge” in chapter 1.

Replace the toner cartridge. See
“Accessories and Supplies Information”
in appendix B.

Try printing a self-test page as described
earlier in this chapter. If the page is still
blank, the printer may need service. See
the support pages at the front of this
manual for support options.

Print is
misaligned on
the page
(Skewed pages).

The Paper Input Bin may be too full.

The paper guides may not be adjusted
properly.

The paper’s weight or surface finish may
not meet HP’s specifications.

Try removing some of the paper.

Be sure to center the paper with the
paper guides. Also, verify that the guides
are not adjusted too tightly or too loosely
against the paper.

To order HP’s paper specification guide,
see “Accessories and Supplies
Information" in appendix B.
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Solving Scanned Image Problems

Symptom Recommended Action

Scanned images are too light or too
dark.

Adjust the brightness sensitivity in the PaperPort software
settings. See “Adjusting Copy and Scan Quality” in chapter 3.

Scanned images have unwanted
lines through them.

Recalibrate the HP LaserJet Companion to improve the image
quality. For more information on recalibrating the HP LaserJet
Companion, see “Recalibrating the HP LaserJet Companion”
later in this chapter. If this does not eliminate unwanted lines,
there may be ink, glue, corrective fluid, or some other substance
on the HP LaserJet Companion’s image sensor. For more
information on cleaning the HP LaserJet Companion, see
“Cleaning the HP LaserJet Companion” later in this chapter.

Scanned text is not clear. Perform the following steps to clear up the text:
1. Adjust the image brightness in the PaperPort software
Settings.
2. Make sure that the scan mode is set to Letter.
3. Recalibrate the HP LaserJet Companion. For information on
recalibrating the HP LaserJet Companion, see the
“Recalibrating the HP LaserJet Companion” section in this
chapter.

Printing Problems with Scanned Items:

Direct copies will not print. If you try to make a direct copy and the printer is out of paper,
has a paper jam, or has some other condition that has sent the
printer offline, then the scan will continue when you clear this
condition.
If you try to make a direct copy and the printer’s Front Panel
lights are off, press the Front Panel button to wake up the
printer, then press [To[Printer] to resume the scan. If you press
[To[Printer] and the printer is not connected to the HP LaserJet
Companion, press [To[PC] to send the scan to the computer.
If direct copies still do not print, reset the HP LaserJet
Companion by disconnecting and reconnecting the power
supply. If the problem persists, refer to the customer service
information in appendix B, “Warranty and Support Information.”

Images are reduced in size. If necessary, the PaperPort software automatically reduces the
size of the image to fit it on the page. For example, if you scan
an 8.5 by 11 inches (21.6 by 27.9 cm) page, then the image in
PaperPort software will be 8.5 by 11 inches (21.6 by 27.9 cm)
from edge to edge. However, most printers cannot print right up
to the edge of the paper.

Images will not print. The HP LaserJet Companion does not support network printers
for direct copies. To make copies using the Direct Copy feature,
the printer must be connected directly to the HP LaserJet
Companion.
Make sure that the HP LaserJet 6L printer and the HP LaserJet
Companion are plugged into a power strip outlet, and that the
outlet is receiving power.
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Symptom Recommended Action

Paper in the printer is large enough
to print the scanned item, but the
image is printed on two pages.

The HP LaserJet Companion has a default of Letter (8.5 by 11
inches, 21.6 by 27.9 cm) or A4 size (210 x 297 mm) paper.
Perform the following steps to change the default paper size:
1. Click Settings in the PaperPort software.
2. Click More.
3. Select the size that matches the size of paper in your printer.
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Recalibrating the HP LaserJet
Companion

Recalibrating the HP LaserJet Companion fine-tunes the amount of
black and white that will appear on the scanned image. Your HP LaserJet
Companion was calibrated at the factory. However, you may need to
recalibrate the HP LaserJet Companion if you noticed that the item
scanned to the computer printed with black or white lines running
through it.

To recalibrate the HP LaserJet Companion
1 Clean the HP LaserJet Companion before recalibrating (see “Cleaning

the HP LaserJet Companion” later in this chapter).
2 Click Settings on the PaperPort desktop tool bar.
3 Click More.
4 Click Calibrate. A message asks you to insert the paper and begin

recalibrating the HP LaserJet Companion.
5 Tear out one of the perforated pages in the back of this manual and

insert the perforated edge of the page into the HP LaserJet Companion.

T i p If you no longer have the perforated sheets in the back of the manual,
you can cut a sheet of blank, white paper to 8.6 inches (21.8 cm) by at
least 6 inches (15.2 cm).

6 Click OK. The HP LaserJet Companion will pull the page through
automatically, and recalibration will be complete.
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Solving HP LaserJet Companion Links
Problems

Symptom Recommended Action

Links in the PaperPort
software do not appear
(Application link does
not appear on the
PaperPort desktop).

If the link is to an e-mail application, see the “Missing E-mail Links” section
later in this table. If the link is to another type of application, go to appendix A
to verify that the application is supported by the PaperPort software. If the
application is supported, see the HP support information at the front of this
manual to contact customer support.

Fax link does not work. In the PaperPort Preferences dialog box, click the Fax category and make
sure that the correct fax driver is selected. With the correct fax driver selected,
the fax software will start when you drop an item onto the Fax Link icon. If the
fax software still does not start, try reinstalling it.

Items lose their
formatting or have
strange formatting
codes in them.

You must configure the word-processor links. Specify the correct output word
processor by choosing Preferences from the Edit menu and then selecting
the word-processing icon under Category.

A high percentage of
incorrect characters
appears in an item that
was converted with the
OCR link.

The accuracy of the OCR link depends on the quality, size, and structure of
the original document and on the quality of the scan itself. To obtain the best
possible results when using the OCR link, choose a scan setting specific to
text and follow these guidelines:
•Process only pages that have crisp, clear text. Letters that have gaps, that
“bleed” along their edges, or that touch other letters will not work well with the
OCR link. Note that underlining and text that is close to non-text items, such
as graphics, will also degrade OCR results.
•Process only pages that contain 9-point text or larger.
•Adjust the OCR, Fax Text mode and adjust the sensitivity setting to get the
densest, clearest letters without any “bleeding” along their edges. See
“Adjusting Copy and Scan Quality” in chapter 3.
•Straighten pages either by rescanning the pages or by using the Straighten
Page command.
•Scan images in 300 dpi rather than 150 dpi.

Missing E-mail Links

Lotus Notes link icon
does not appear.

The link to Lotus Notes requires the file NOTES.EXE. The path to this file
must be typed in the LOTUS.INI file. To make sure that the Lotus Notes icon
appears, follow these steps:
1. Check that the file LOTUS.INI exists in your Windows directory. (If not, skip
steps 2 and 3.)
2. Check this file for the line Notes=<path> .
3. Check this path for the NOTES.EXE file. If either is missing, try reinstalling
your Notes client.
4. Check your WIN.INI file for the [Mail] section. Make sure that there is a
key entry of SMI=1 .
In some cases, Lotus Notes may be configured so that the PaperPort
software cannot find the files SM1.DLL or NOTES.EXE. In MAXOPTS.INI (in
the c:\PAPRPORT directory), add the following line in the section [Lotus
Notes Mail Link] specifying the path to NOTES.EXE:
AppFile=c:\NOTES\NOTE.EXE
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Symptom Recommended Action

Lotus cc:Mail link icon
does not appear.

Contact your e-mail system administrator. The link to Lotus cc:Mail requires a
Lotus cc:Mail file called VIM (Virtual Interface for Messaging).
NOTE: VIM files were not shipped with Lotus cc:Mail versions prior to 2.0, but
they can be downloaded from the cc:Mail forum on CompuServe and from the
Lotus cc:Mail bulletin board service (BBS).
•If the VIM files are installed but the cc:Mail link still does not appear, check
your WIN.INI file for the line SMI=1 in the section [Mail] and the entry
Program Path=<path> in the section [cc:Mail] .
•Check this directory for the presence of these VIM files: CCEDIT.DLL,
CCUTIL.DLL, VIM.DLL, SMI.DLL, CCSMI.DLL, CHARSET.DLL,
COMDLG.DLL, MAILENG.DLL, MEMAN.DLL, CDVIM.DLL, VERINFO, and
README.TXT.
If any of these files are missing, cc: Mail has not been properly installed in this
directory. Try reinstalling it.

Microsoft Mail link icon
does not appear.

The Microsoft Mail link requires the file MAPI.DLL. Check the following items
to verify this file is in the correct place:
•Make sure that the path to this file, which is usually C:\MSMail, is included in
the path statement in your AUTOEXEC.BAT file.
•The WIN.INI file must include the line MAPI=1 in the [Mail] section.
Note:Installing Novell GroupWise will overwrite MAPI.DLL, making Microsoft
Mail unavailable.

WordPerfect Office link
icon does not appear.

1. Make sure that the file WPC.INI in your Windows directory contains the line
WPOF=<path>\ofwin.exe (where <path> represents the location of
OFWIN.EXE) in the [AppServer] section.
2. Make sure that the file WIN.EXE is in the specified path. If it is not, check
with your network or system administrator.
Note: If Novell GroupWise has been installed, the WordPerfect Office link will
disappear. Novell GroupWise is an upgrade to the WordPerfect Office.

Da Vinci eMAIL link
icon does not appear.

1. From the Edit menu, choose Preferences. The PaperPort Preferences
dialog box appears.
2. Click the Da Vinci icon in the Category area.
3. Type the path for the Da Vinci EMAINWIN.EXE file.
4. Run Da Vinci eMAIL at least once on your computer before running the
PaperPort software so the link icon appears.
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Solving HP LaserJet Companion
Import and Export File Problems

“Import Fax for WinFax PRO 4.0” does not appear
in the File menu.
Check your WIN.INI file for the line Fax Path=<path> under the
section[winfax] , and then check this path for the file STATUS.FTM. If
either is missing, try reinstalling WinFax PRO.

Exported files expand in size when opened in a
paint program.
Many paint programs ignore the dpi resolution information in BMP, PCX,
and TIF files. These programs assume that the resolution of the file is the
same as the current screen resolution. Because these files actually
contain more information than the screen can display, they grow in size.
The following are some possible solutions:

Instead of using the Export command, you can open the item in Page
View, copy the information, and then paste it into the program you want
to use or into a new file in a paint program. You can also open the file in
a graphic’s program that accurately reads the dpi resolution contained in
the file.

Unable to import a file.
Check whether the file you want to import is saved in an appropriate
format, such as BMP, PCX, or TIF. If it is none of these formats, select
the file type you want and try importing the file again.

You can also try opening the file in a paint program and saving it as a
BMP file under a new file name. Open the new file in the PaperPort
software.
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Solving Hard-to-Resolve Problems

The following instructions will help you troubleshoot Windows printing
problems using DOS.

N o t e Before troubleshooting from DOS, make sure your printer can print a
self-test page. (See “Printing a Self-Test Page” earlier in this chapter.)

To establish basic communication to the printer, follow the steps below:

1 Exit Windows 3.1x. If in Windows 95, choose Start, Shut Down, and
Restart the computer in MS-DOS® mode, respectively.

2 At the command prompt (for example, c:\), type: Dir>PRN and press
ENTER. This sends a directory of your hard drive to your printer.

3 See the chart below for recommended solutions.

Printer Status Response Solution(s)

Both the Data light and
the Ready light are on
steadily (not blinking).

Command prompt (c:\)
returned.

Press the Front Panel button.
You will receive a printout of your hard drive’s
directory.
Communication verified; return to Windows.

Data light comes on;
Ready light flashes.

Command prompt (c:\)
returned.

No action is needed. Communication has been
verified; return to Windows.

Printer is not
responding.

Flashing cursor;
command prompt (c:\)
not returned; keyboard
locked up.

Verify that the Ready light is on.
Hold down CTRL, then press and release Break
to free the keyboard.
Disconnect, then reconnect the parallel cable at
both ends.
Reboot your computer.
Ensure a direct connection to the printer.
Trying using a different parallel cable
(IEEE-1284), parallel port, or both.

Printer is not
responding.

DOS message: “Write
Fault error writing device
PRN.”

Verify that the Ready light is on.
Specify the port name when sending directory
(for example, LPT1).
Verify that the power cord and the parallel cable
are plugged into the proper ports.
Disconnect, then reconnect the parallel cable at
both ends.
Ensure a direct connection to the printer.
Trying using a different parallel cable
(IEEE-1284), parallel port, or both.
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Printer Status Response Solution(s)

Printer is not
responding.

Command prompt (c:\)
returned.

Disconnect, then reconnect the parallel cable at
both ends.
Ensure a direct connection to the printer.
Hold down CTRL, then press and release Break
to free the keyboard.
Trying using a different parallel cable
(IEEE-1284), parallel port, or both.

Data light comes on;
Ready light flashes.
Printed text is not
legible, or random
characters are
occurring on the page.

Command prompt (c:\)
returned.

Disconnect, then reconnect the parallel cable at
both ends.
Ensure a direct connection to the printer.
Trying using a different parallel cable
(IEEE-1284), parallel port, or both.

Data light comes on;
Ready light flashes.
Only one line of text
prints or all text is on
one line.

Command prompt (c:\)
returned.

Disconnect, then reconnect the parallel cable at
both ends.
Ensure a direct connection to the printer.
Trying using a different parallel cable
(IEEE-1284), parallel port, or both.

Text files print. Graphic
files do not print or
print garbage.

No error messages.
All appears ok.

Disconnect, then reconnect the parallel cable at
both ends.
Ensure a direct connection to the printer.
If copying a graphic file, type the following
command at the command prompt:

copy filename LPT1
where filename is the name of the graphic file.
(Be sure to leave a space before and after the file
name.)
Try using a different parallel cable (IEEE-1284),
parallel port, or both.
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Maintenance

To prevent excessive wear and preserve
print quality, keep your printer and
scanner free of excessive dust and debris.

Cleaning Your HP LaserJet
6L Printer

N o t e
If you notice excessive amounts of toner
inside your printer, your toner cartridge
may be defective. It is recommended that
you use HP LaserJet toner cartridges to
insure high quality printing and to reduce
incidents of excessive toner in your printer.

W A R N I N G !
Before cleaning the printer, disconnect it
from the power source.

C a u t i o n
Using ammonia-based cleaners on or
around the printer can cause damage to
the printer. Also, do not touch the black
sponge roller inside the printer. By doing
so, you can reduce the print quality of
your media.

To clean the printer
1 Clean the outside of the printer with a

slightly damp cloth (use only water).
2 Clean the inside of the printer with a

dry, lint-free cloth. Remove all dust,
spilled toner, and particles of paper.

N o t e
If toner gets on your clothing, wipe it off
with a dry cloth and wash clothing in cold
water. Hot water sets toner into the fabric.
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Cleaning Your HP LaserJet
Companion

You might need to clean the HP LaserJet
Companion after scanning approximately
ten pages of newsprint, if the ink on an
item can be smudged with your hand, or
if you scan items that have excessive
amounts of dirt or dust on them.

To clean the roller and image
sensor

1 Pull forward on the release levers and
open the cover.

2 Dip a cotton swab in rubbing alcohol
(pH7 or neutral pH) or glass cleaner.

3 Press either [To[Printer] or [To[PC] on
the HP LaserJet Companion to rotate
the roller, and wipe the white roller
with the cotton swab.

4 Spray glass cleaner on a new cotton
swab and clean the glass on the
image sensor.

C a u t i o n
Do not spray cleaner or any other liquid
directly on or into the HP LaserJet
Companion as this will damage the HP
LaserJet Companion. Whenever cleaning,
direct spray away from the open part of
the HP LaserJet Companion.
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A

Specifications

HP LaserJet 6L Printer Specifications

Environmental Specifications

Operating Environment (Printer plugged into an AC outlet):
Temperature: 10 ºC to 32.5 ºC (50 ºF to 90.5 º F)
Humidity: 20%-80% (no condensation)

Storage Environment (Printer unplugged from the AC outlet):
Temperature: 0 ºC to 40 ºC (32 ºF to 104 ºF)
Humidity: 10%-80% (no condensation)

Noise Level During printing: 5.5 Bels Sound Power Level (per ISO 9296)
During Standby and SleepMode: silent

Electrical Specifications

Power Requirements 100-120 v (+/-10%), 50/60 Hz (+/- 2); 127 v NOM, 6C
220 v (+/-10%), 50/60 Hz (+/- 2 Hz)
240 v (+/-10%), 50 Hz (+/- 2 Hz)

Power Consumption During printing: 120 W (average)
During standby or SleepMode: 5 W

Minimum Recommended Circuit Capacity 4.5 A @ 115 V, 2.0 A @ 230 V

Physical Specifications

Dimensions:
Width
Depth
Storage Height
Operating Height (Letter Height)

335.2 mm (13.2 in)
312.4 mm (12.3 in)
228.6 mm (9.0 in)
370.8 mm (14.6 in)

Weight (Cartridge Installed) 7.0 kg (15.5 lb)

Print speed 6 pages per minute

Paper Input Bin capacity Holds up to 100 sheets of regular weight paper or up to 10 envelopes

Paper Output Bin capacity Holds up to 100 sheets

Front Output Slot capacity Stack 1 transparency or up to 20 sheets of other media in front of the Front
Output Slot

Minimum paper size 76.2 x 127 mm (3 x 5 in)

Maximum paper size 215.9 x 355.6 mm (8.5 x 14 in)

Base memory 2 MB of ROM and 1 MB of RAM

Upgradable Memory Expansion One slot available for a 1-, 2-, 4-, or 8-MB, 70ns or faster, 5 V JEIDA card

Print Resolution 600 dots per inch (dpi)

Duty Cycle 6000 single-sided pages per month

EN Specifications A-1
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HP LaserJet Companion Hardware
Specifications

Output

Scanning Resolution 300 dpi

Item Sizes

Maximum 8.5 x 30 inches (21.6 x 76.2 cm)

Minimum 2 x 3.5 inches (5.1 x 8.9 cm)

HP LaserJet Companion Dimensions

Height 5.87 inches (14.9 cm) closed
7.13 inches (19.0 cm) paper tray open
13.19 inches (33.6 cm) paper tray open and
paper supports extended

Width 3.62 inches (9.2 cm) closed
4.09 inches (10.4 cm) paper tray open
6.26 inches (15.9 cm) paper tray open and
paper supports extended

Length 12.44 inches (31.6 cm)

Weight 3.31 pounds (1.5 kg)

Environment

Scanning / Standby 50 to 104° F (10 to 40 C)
15% to 80% RH

Storage 32 to 140° F (0 to 60 C)
10% to 90% RH

Power Supply

Available AC Adapter Inputs 120-127V (+6% / -10%), 60Hz (±2Hz)
220V (+6% / -10%), 50/60Hz (±2Hz)
230V (+6% / -10%), 50/60Hz (±2Hz)
240V (+6% / -10%), 50/60Hz (±2Hz)

AC Adapter Output 18Vdc, 730 mA

Operating Power 21 watts

Standby Power 4 watts
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PaperPort Software Specifications

Input

HP LaserJet Companion
Printer Accessory

Optical resolution 300 dpi

Scanning modes OCR, Fax text: 300 dots per inch (dpi), 1 bit per
pixel (bpp), thresholded
Fax drawing: 300 dpi, 1 bpp, dithered
Business Card: 300 dpi, 4 bpp
Sketch (line art): 150 dpi, 4 bpp
Edit image: 150 dpi, 8 bpp
Custom: 150 or 300 dpi; 1 bpp thresholded, 1 bpp
ordered dithered, 1 bpp random dithered, 4 bpp, or
8 bpp

Print to the PaperPort Desktop Up to 300 dpi x 300 dpi

Imported Images Up to 2400 dpi x 2400 dpi

Output

Supported printers LaserJet 4-, 5-, or 6- series printers

Supported export/import
formats

PaperPort for Windows, TIFF (multiple formats),
multi-page PCX, DCX, GIF, BMP, and JPEG

Supported third-party
applications (and minimum
supported version levels)

Adobe Photoshop 2.5 and 3.0, Caere FaxMaster,
Caere Omni Page Direct, Caere OmniPage LITE,
Caere OmniPage Limited Edition, Caere OmniPage
Pro, CompuServe Mail, Corel PhotoPaint, DaVinci
eMAIL, Delrina WinFax, ExpressFax, FaxAbility,
FaxMaster, Fax Sender, FaxWorks, Intel FaxAbility,
Intel Proshare, KidPix, Lotus AmiPro, Lotus 1-2-3,
Lotus cc:Mail, MS Word, MS Write, Netscape
Navigator, Novell GroupWise, Novell Quatro Pro,
PC Paintbrush, Phoenix Eclipse FAX, Proshare, Trio
Datafax, UltraFax, WordPerfect, WordPerfect Office,
WordStar, Zsoft

Maximums

Number of pages per stack 2,500

Number of annotations per
page

300

Length of item name 30 characters

Length of a scan page 30 inches (76.2 cm)
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HP LaserJet Companion Printer
Accessory Product Safety
Specifications

The product meets the following specifications:

UL 1950, Third Edition

CAN/CSA C22.2 No. 950-95

IEC 950:1991 +A1:1992 + A2:1993 + A3:1994

CENELEC EN 60950:1992 + Am1:1992 + Am2:1993 + Am3:1994

EMKO-TSE (74-SEC) 207/94

IEC 825-1:1996 (Class 1 LED)

CENELEC EN 60825-1:1994 (Class 1 LED)

NOM-019-SCFI-1993
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HP LaserJet 6L Printer Environmental
Product Stewardship

Hewlett-Packard has created the Environmental Product Stewardship
program on a corporate-wide level to ensure that HP products conform
to national and worldwide environmental standards.

Protecting the Environment

Hewlett-Packard Company is committed to providing quality products in
an environmentally-sound manner. This HP LaserJet printer has been
designed with several attributes to minimize impacts on our environment.

This HP LaserJet printer design eliminates:

• Ozone production

This HP LaserJet printer does not use high-voltage corona wires in the
electrophotographic process. Instead, it uses charging rollers in the
toner cartridge and in the print engine. Therefore, this printer does not
generate appreciable ozone gas (O3).

• CFC usage

Ozone-depleting chemicals (Chloroflorocarbons, for example) have been
eliminated from the manufacturing sites of this printer. CFCs are not
used in the manufacturing of the packaging.

This HP LaserJet printer design reduces:

• Energy consumption

Energy usage drops from an average of 120W during printing to as little
as 5W while in Standby/Sleep mode. Not only does this save natural
resources, but it also saves money without affecting the high
performance of this printer. This product qualifies for the United States
Environmental Protection Agency’s ENERGY STAR Program. ENERGY
STAR is a voluntary program established to encourage the development
of energy-efficient office products.

As an ENERGY STAR partner, Hewlett-Packard Company has
determined that this product meets ENERGY STAR Guidelines for
energy efficiency.
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• Toner consumption

EconoMode uses about 50% less toner thereby extending the life of the
toner cartridge.

• Paper use

This printer allows manual duplexing (two-sided printing) and this
reduces paper usage and the resulting demands on natural resources.

• Transportation fuel consumption and emissions

HP LaserJet printers are shipped from manufacturing sites to distribution
centers in bulk packs. Because more printers can fit on each pallet, fuel
consumption and emissions are reduced.

HP LaserJet Printer: Worldwide Recycling

• Plastics

Major plastic parts have markings which enhance the ability to identify
and recycle the materials at the end of the printer’s life.

• Manuals

The manuals are printed on recycled paper using vegetable-based inks
without added heavy metals. Therefore, the manuals are recyclable.

• Paper

This printer is suited for the use of recycled papers that meet the HP
LaserJet Printer Family Paper Specification Guide. See Appendix A for
part numbers and ordering information.

HP LaserJet Printer: U.S.A. Recycling

• Toner cartridges

Each HP LaserJet Toner Cartridge box sold in the U.S. contains
instructions and a shipping label for returning the cartridge to HP for
recycling. HP pays the postage.

• Printer and parts

HP’s Hardware Recycling Organization will take back this printer and
other HP products when you have no further use for them. HP disposes
of these products in an environmentally-sound manner. Many of the
functional parts are recovered, tested, and reused as fully warranted
service parts (used parts are not used in new product manufacturing).
The remainder of the product parts are recycled if possible. Call (800)
535-7933 for this service
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Laser Safety Statement

The Center for Devices and Radiological Health (CDRH) of the U.S.
Food and Drug Administration has implemented regulations for laser
products manufactured since August 1, 1976. Compliance is mandatory
for products marketed in the United States. This printer is certified as a
“Class 1" laser product under the U.S. Department of Health and Human
Services (DHHS) Radiation Performance Standard according to the
Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside this printer is completely confined within protective
housings and external covers, the laser beam cannot escape during any
phase of normal user operation.

W A R N IN G ! Use of controls or adjustments or performance of procedures other than
those specified in this manual may result in hazardous radiation
exposure.
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Declaration of Conformity: HP LaserJet 6L
Printer

according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name: Hewlett-Packard Company
Manufacturer’s Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares that the product

Product Name: HP LaserJet 6L printer; Laser Printer
Model Number: C3990A
Product Options: ALL

conforms to the following Product Specifications:

Safety: IEC 950:1991+A1+A2+A3 / EN 60950:1992+A1+A2+A3
IEC 825-1:1993/EN 60825:1994 Class 1 (Laser/LED)

EMC: CISPR 22:1993+A1 / EN 55022:1994 Class B1
EN 50082-1:1992

IEC 801-2:1991 / prEN 55024-2:1992- 4 kV CD, 8 kV AD
IEC 801-3:1984 / prEN 55024-3:1991- 3 V/m
IEC 801-4:1988 / prEN 55024-4:1992- 0.5 kV Signal Lines

1.0 kV Power Lines
IEC 1000-3-2:1995 / EN61000-3-2:1995
IEC 1000-3-3:1994 / EN61000-3.3:1995
FCC Title 47 CFR, Part 15 Class B2 / ECES-003, Issue 2/VCCI-21
AS/NZS 3548:1992/CISPR 22:1993 Class B1

Supplementary Information:

The product herewith complies with the requirements of the following Directives
and carries the CE-marking accordingly.

- the EMC Directive 89/336/EEC
- the Low Voltage Directive 73/23/EEC

1 The product was tested in a typical configuration with Hewlett-Packard Personal
Computer Systems.
2 This Device complies with Part 15 of the FCC rules. Operation is subject to the
following conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation. December 1, 1996

For Compliance Information ONLY, contact:

Australia Contact: Product Regulations Manager, Hewlett-Packard Australia Ltd., 31-41 Joseph
Street, Blackburn, Victoria 3130, Australia

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh,
Department HQ-TRE/Standards Europe, Herrenberger Strasse 130, D-71034
Boblingen (FAX: 49-7031-14-6429)

USA Contact: Product Relations Manager, Hewlett-Packard Company, P.O. Box 15, MS 160,
Boise ID 83707-0015 (Phone: 208-396-6000)
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Declaration of Conformity: HP LaserJet
Companion Printer Accessory

according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name: Hewlett-Packard Company
Manufacturer’s Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares that the product

Product Name: HP LaserJet Companion Printer Accessory
Model Number: C3989A
Product Options: ALL

conforms to the following Product Specifications:

Safety: IEC 950:1991+A1+A2+A3 / EN 60950:1992+A1+A2+A3
IEC 825-1 / EN 60825-1 (Class 1 LED)

EMC: CISPR-22:1993 / EN 55022:1994 class B
EN 50082-1:1992

IEC 801-2:1991 / prEN55024-2:1992- 3 kV CD, 8kV AD
IEC 801-3:1984 / prEN55024-3:1991- 3 V/m
IEC 801-1:1988 / prEN55024-4:1992- 1 kV Power Lines

IEC 1000-3-2:1995 / EN61000-3-2:1995
IEC 1000-3-3:1994 / EN61000-3.3:1995
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 2
AS / NZS 3548:1992 / CISPR 22:1993 Class B

Supplementary Information:

The product herewith complies with the requirements of the following Directives
and carries the CE-marking accordingly:
- the EMC Directive 89/336/EEC (inclusive 93/68/EEC)
- the Low Voltage Directives 73/23/EEC

The product was tested in a typical configuration with Hewlett-Packard Personal
Computer and Test Systems.

For Compliance Information ONLY, contact:

Australia Contact: Product Regulations Manager, Hewlett-Packard Australia Ltd., 31-41 Joseph
Street, Blackburn, Victoria 3130, Australia

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh,
Department HQ-TRE/Standards Europe, Herrenberger Strasse 130, D-71034
Boblingen (FAX: +49-7031-14-3143)

USA Contact: Product Relations Manager, Hewlett-Packard Company, P.O. Box 15 Mail Stop
160, Boise ID 83707-0015 (Phone: 208-396-6000)
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B

Warranty and Support Information

HP Limited 1-Year Warranty Statement

1 HP warrants to you, the end-user customer, that HP hardware,
accessories and supplies, will be free from defects in materials and
workmanship after the date of purchase, for the period specified above.
If HP receives notice of such defects during the warranty period, HP will,
at its option, either repair or replace products which prove to be
defective.

2 HP warrants to you that HP software will not fail to execute its
programming instructions after the date of purchase, for the period
specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during
the warranty period, HP will replace software media which does not
execute its programming instructions due to such defects.

3 HP does not warrant that the operation of HP products will be
uninterrupted or error free. HP products may contain remanufactured
parts equivalent to new in performance or may have been subject to
incidental use. If HP is unable, within a reasonable time, to repair or
replace any product to a condition as warranted, you will be entitled to a
refund of the purchase price upon prompt return of the product.

4 Warranty does not apply to defects resulting from (a) improper or
inadequate maintenance or calibration, (b) software, interfacing, parts or
supplies not supplied by HP, (c) unauthorized modification or misuse, (d)
operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

5 ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE IS LIMITED TO THE DURATION OF
THE EXPRESS WARRANTY SET FORTH ABOVE. Some states or
provinces do not allow limitations on the duration of an implied warranty,
so the above limitation or exclusion might not apply to you. This warranty
gives you specific legal rights and you might also have other rights that
vary from state to state, province to province, or country to country.

6 THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE
AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN
NO EVENT WILL HP BE LIABLE FOR LOSS OF DATA OR FOR
DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING
LOST PROFIT), OR OTHER DAMAGE, WHETHER BASED IN
CONTRACT, TORT, OR OTHERWISE. Some states or provinces do not
allow the exclusion or limitation of incidental or consequential damages,
so the above limitation or exclusion may not apply to you.
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Hardware Service during the Warranty
Period

If your hardware should fail during the warranty period, HP offers the
following support options:

• Express Exchange (available in the U.S. and Canada only): HP
provides a printer (remanufactured to like new condition) to you on the
next working day.

• HP Authorized Service Provider: You can return your printer to a local
authorized service dealer.

• HP Repair Services: You can return your printer to an HP repair office.

When sending equipment, we recommend insuring the equipment for
shipment. Also include a copy of your proof of purchase.

C a u t i o n Shipping damage as a result of inadequate packaging is the customer’s
responsibility. Use the original packing materials whenever possible.

For technical support assistance regarding your printer within the
one-year warranty period, see the support pages at the front of this
manual.

Hardware Service after the Warranty Period

If your hardware fails after the warranty period, contact an authorized
Hewlett-Packard Dealer Repair Center or a designated Hewlett-Packard
Repair Center. If you have a Hewlett-Packard Maintenance Agreement,
request service under your agreement.

HP LaserJet Toner Cartridge Warranty

HP LaserJet toner cartridges are warranted to be free from defects in
materials and workmanship until the HP toner is depleted. You know
your HP toner is depleted when you begin to see faded or light type on
your printed page.

The warranty, extended for the life of the cartridge, covers any defects or
malfunctions in your new Hewlett-Packard toner cartridge. HP will, at
HP’s option, either replace products which prove to be defective or
refund your purchase price.

In the event the cartridge proves to be defective, attach a printout
sample illustrating what the defective cartridge is printing and return to
the place of purchase.

IN NO EVENT SHALL HEWLETT-PACKARD COMPANY BE LIABLE
FOR ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL, INDIRECT,
PUNITIVE, OR EXEMPLARY DAMAGES OR LOST PROFITS FROM
ANY BREACH OF THIS WARRANTY OR OTHERWISE.
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Accessories and Supplies Information

The following table lists items that are available from HP Direct Ordering
and through your local authorized HP dealer.

• For most items, call HP Direct Ordering at (800) 538-8787 (U.S.). To
order HP LaserJet paper, call (800) 471-4701.

• To find a dealer near you (or if your dealer is temporarily out of stock),
call the HP Customer Information Center (800) 752-0900.

• For ordering information outside of the U.S., see “Worldwide Sales and
Service Offices” in this appendix.

Option Part Number

HP LaserJet
Printer Family Paper
Specification Guide 5002-1801

HP LaserJet toner
cartridge

C3906A
C3906F (Asia only)

HP LaserJet parallel
printer cable (IEEE-1284)

Two meter A to B:
Three meter A to B:

C2950A
C2951A

1 MB Memory Upgrade
2 MB Memory Upgrade
4 MB Memory Upgrade

C3939A HP Jeida Memory Card
C3938A HP Jeida Memory Card
C3148A HP Jeida Memory Card

Transparencies
Letter
A4

C2934A
C2936A

Labels 92296A - H/J/K Various Sizes

HP MultiPurpose Paper
HP LaserJet Paper

HPM 1120 - High bright, 20 lb., 8.5 x 11 inch
HPJ 1124 - Extra bright, 24 lb., 8.5 x 11 inch
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HP Software License Agreement

ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE LICENSE TERMS SET FORTH
BELOW. USING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE LICENSE TERMS.

HP SOFTWARE LICENSE TERMS
The following License Terms govern your use of the accompanying Software unless you have a separate written
agreement with HP.

License Grant. HP grants you a license to Use one copy of the Software. “Use” means storing, loading, installing,
executing or displaying the Software. You may not modify the Software or disable any licensing or control features
of the Software. If the Software is licensed for “concurrent use”, you may not allow more than the maximum
number of authorized users to Use the Software concurrently.

Ownership. The Software is owned and copyrighted by HP or its third party suppliers. Your license confers no title
or ownership in the Software and is not a sale of any rights in the Software. HP’s third party suppliers may protect
their rights in the event of any violation of these License Terms.

Copies and Adaptations. You may only make copies or adaptations of the Software for archival purposes or when
copying or adaptation is an essential step in the authorized Use of the Software. You must reproduce all copyright
notices in the original Software on all copies or adaptations. You may not copy the Software onto any bulletin board
or similar system.

No Disassembly or Decryption. You may not disassemble or decompile the Software unless HP’s prior written
consent is obtained. In some jurisdictions, HP’s consent may not be required for disassembly or decompilation.
Upon request, you will provide HP with reasonably detailed information regarding any disassembly or
decompilation. You may not decrypt the Software unless decryption is a necessary part of the operation of the
Software.

Transfer. Your license will automatically terminate upon any transfer of the Software. Upon transfer, you must
deliver the Software, including any copies and related documentation, to the transferee. The transferee must
accept these License Terms as a condition to the transfer.

Termination. HP may terminate your license upon notice for failure to comply with any of these License Terms.
Upon termination, you must immediately destroy the Software, together with all copies, adaptations and merged
portions in any form.

Export Requirements. You may not export or re-export the Software or any copy or adaptation in violation of any
applicable laws or regulations.

U.S. Government Restricted Rights. The Software and documentation have been developed entirely at private
expense and are provided as “Commercial Computer Software” or “restricted computer software.” They are
delivered and licensed as “commercial computer software” as defined in DFARS 252.227-7013 (Oct 1988), DFARS
252.211-7015 (May 1991) or DFARS 252.227-7014 (Jun 1995), as a “commercial item” as defined in FAR 2.101
(a), or as “Restricted computer software” as defined in FAR 52.227-19 (Jun 1987) (or any equivalent agency
regulation or contract clause), whichever is applicable. You have only those rights provided for such Software and
Documentation by the applicable FAR or DFARS clause or the HP standard software agreement for the product.
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Worldwide Sales and Service Offices

Hewlett-Packard products are sold and supported worldwide through Hewlett-Packard Sales and Service
Offices and through dealers. There are more than 240 Hewlett-Packard Sales and Service Offices
worldwide.

Argentina:
Hewlett-Packard Argentina
Montañeses 2140/50/60
1428 Buenos Aires
Phone: (54 1) 787-7100
Fax: (54 1) 787-7213

Australia:
Hewlett-Packard Australia Ltd.
31-41 Joseph Street
Blackburn, VIC 3130
Phone: (61 3) 272-2895
Fax: (61) 3/898-7831
Hardware Repair Center and Extended
Warranty Support: 131047
Customer Information Center: 131347

Before calling an HP Sales and
Service office, be sure to contact
the appropriate Customer Support
Center number listed in the front of
your manual.

Austria:
Hewlett-Packard GmbH
PO Box 72
Lieblgasse 1
A-1222 Wien
Phone: (43) 1-25 000-0
Fax: (43) 1-25 000-444

Belgium:
Hewlett-Packard Belgium SANV
Boulevard de la Woluwe
100 Woluwedal
B-1200 Bruxelles
Phone: (32 2) 761-31-11
Fax: (32 2) 763-06-13

Canada:
Hewlett-Packard (Canada) Ltd.
17500 Trans Canada Highway
South Service Road
Kirkland, Québec H9J 2X8
Phone: (514) 697-4232
Fax: (514) 697-6941

Hewlett-Packard (Canada) Ltd.
5150 Spectrum Way
Mississauga, Ontario L4W 5G1
Phone: (905) 206-4725
Fax: (905) 206-4739

Brazil:
Edisa Hewlett-Packard SA
Av. Do Contorno, 6321
12° andar
30110-110—Belo Horizonte—MG
Phone: (55 31) 221-8845
Fax: (55 31) 221-8836

China:
China Hewlett-Packard Co. Ltd.
Level 5, West Wing Office
China World Trade Center
No. 1, Jian Guo Men Wai Avenue
Beijing 100004
Phone: (86 1) 505-3888, ext. 5450
Fax: (86 1) 505-1033
Hardware Repair Center and
Extended Warranty Support:
(8610) 6262-5666 ext. 6101/2
6261-4167

Czech Republic:
Hewlett-Packard S.R.O.
Novodvorská 82
CZ-14200 Praha 4
Phone: (42 2) 613 07 111
Fax: (42 2) 47 17 611

Denmark:
Hewlett-Packard A/S
Kongevejen 25
DK-3460 Birkerød
Phone: (45 45) 99 10 00
Fax: (45 42) 81 58 10

Far East Region:
Hewlett-Packard Asia Pacific Ltd.
17-21/F Shell Tower, Times Square
1 Matheson Street, Causeway Bay
Hong Kong SAR
Phone: (852) 2599-7777
Fax: (852) 2506-9244
Hardware Repair Center:
(852) 2599-7000
Extended Warranty Support:
(852) 2599-7000
Customer Information Center:
(852) 2599-7066

Finland:
Hewlett-Packard Oy
Piispankalliontie 17
FIN-02200 Espoo
Phone: (358 0) 887 21
Fax: (358 0) 887 2477

France:
Hewlett-Packard France
42 Quai du Point du Jour
F-92659 Boulogne Cedex
Phone: (33) 146/10 17 00
Fax: (33) 146/10 17 05

Germany:
Hewlett-Packard GmbH
Herrenberger Strasse 130
71034 Böblingen
Phone: 0180-5326222
0180-5258143
Fax: 0180 5316122

Greece:
Hewlett-Packard Hellas
62, Kifissias Avenue
GR-15125 Maroussi
Phone: (30) (1) 68 96 411
Fax: (30 1) 68 96 508
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Hungary:
Hewlett-Packard Magyarorszag
Erzsebet kiralyne utja 1/c
H-1146 Budapest
Phone: (36 1) 122-7411
(36 1) 252-4505
Fax: (36 1) 122-3692

India:
Hewlett-Packard India Ltd.
Paharpur Business Centre
21 Nehru Place
New Delhi 110 019
Phone: (91 11) 6472311
Fax: (91 11) 6461117
Hardware Repair Center and
Extended Warranty Support:
(011) 6425073

Italy:
Hewlett-Packard Italiana SpA
Via Giuseppe di Vittorio, 9
Cernusco Sul Naviglio
I-20063 (Milano)
Phone: (39 2) 92 12 1
Fax (39 2) 921 044 73

Japan:
Hewlett-Packard Japan, Ltd.
3-29-21 Takaido-higashi
Suginami-ku, Tokyo 168
Phone: (81 3) 3331-6111
Fax: (81 3) 3335-1478
Hardware Repair Center:
0473-55-6660

Korea:
Hewlett-Packard Korea
25-12, SHP House
Yoido-dong, Youngdeungpo-ku
Seoul 150-010
Phone: (82 2) 769-0114
Fax: (82 2) 784-7084
Hardware Repair Center:
(02) 3270-0710
Extended Warranty Support:
(82 2) 3770-0365, 3770-0359

Latin American Headquarters:
5200 Blue Lagoon Drive
Suite 950
Miami, FL 33126
U.S.A.
Phone: (305) 267-4220

México, D.F.:
Hewlett-Packard de México,
SA de CV
Prolongación Reforma No. 700
Lomas de Santa Fe
01210 México, DF
Phone: (52 5) 326-4600
Fax: (52 5) 326-4274

México, Guadalajara:
Hewlett-Packard de México,
SA de CV
Monte Morelos No. 299
Fracc. Loma Bonita
45060 Guadalajara, Jal.
Phone: (52 3) 669-9302
Fax: (52 3) 669-9560

México Monterrey:
Hewlett-Packard de México,
S.A. de C.V.
Batallón de San Patricio 111
Piso 23-Torre Comercial América
Colonia del Valle
66269 Garza Garcia, Nuevo León
Phone: (52 8) 368-5100
Fax: (52 8) 356-7498

Middle East/Africa:
ISB HP Response Center
Hewlett-Packard SA
Rue de Veyrot 39
P.O. Box 364
CH-1217 Meyrin - Geneva
Switzerland
Phone: (41) 22 780 41 11

Netherlands:
Hewlett-Packard Nederland BV
Startbaan 16
NL-1187 XR Amstelveen
Postbox 667
NL-1180 AR Amstelveen
Phone: (31 20) 547 69 11
Fax: (31 20) 547 77 55

New Zealand:
Hewlett-Packard (NZ) Limited
Ports of Auckland Building
Princes Wharf, Quay Street
PO Box 3860
Auckland
Phone: (64 9) 356-6640
Fax: (64 9) 356-6620
Hardware Repair Center and
Extended Warranty Support:
0800 733 547
Customer Information Center:
0800-651-651

Norway:
Hewlett-Packard Norge A/S
Postboks 60 Skøyen
Drammensveien 169
N-0212 Oslo
Phone: (47) 22 73 56 00
Fax: (47) 22 73 56 10

Poland:
Hewlett-Packard Polska
ul.Newelska 6
PK-01-447 Warszawa
Phone: (48) 22 375065
Fax: (48) 22 374783

Portugal:
Hewlett-Packard Portugal
Rua Gregório Lopes
Lote 1732B
P-1400 Lisboa
Phone (351 1) 3017330
Fax: (351 1) 3017345

Russia:
AO Hewlett-Packard
Business Complex Building #2
129223, Moskva, Prospekt Mira
VVC
Phone: (7 095) 928-6885
Fax: (7 095) 974-7829

Singapore:
H-P Singapore (Pte), Ltd.
150 Beach Road
#29-00
Gateway West
Singapore 0718
Phone: (65) 291-9088
Fax: (65) 292-7089
Hardware Repair Center and
Customer Information Center:
(65) 272-5300
Extended Warranty Support
Contact: (65) 3743173

Spain:
Hewlett-Packard Española, SA
Carretera de la Coruña km 16.500
E-28230 Las Rozas, Madrid
Phone: (34 1) 626 16 00
Fax (34 1) 626 18 30
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Sweden:
Hewlett-Packard Sverige AB
Skalholtsgatan 9, Box 19
S-164 93 Kista
Phone: (46 8) 444-2000
Fax: (46 8) 444-7781

Switzerland:
Hewlett-Packard (Schweiz) AG
In der Luberzen 29
CH-8902 Urdorf/Zürich
Phone: (41) 1/753 71 11
Fax: (41) 1/753 77 00

Taiwan:
Hewlett-Packard Taiwan Ltd.
8th Floor
337, Fu-Hsing North Road
Taipei, 10483
Phone: (886 2) 712-0404
Fax: (886 2) 715-3107
Hardware Repair Center:
02-717-9673 (North Taiwan)
04-327-0153 (Central Taiwan)
080-733-733 (South Taiwan)
Extended Warranty Support Contact:
080 211-666

Thailand:
Hewlett-Packard (Thailand) Ltd.
11th Floor Pacific Place
140 Sukhumvit Road
Bangkok 10110
Phone: (66 2) 254-6720
Fax: (66 2) 254-6731
Hardware Repair Center:
(66 2) 661-3900/1/2 ext 6001 ext 6002
Extended Warranty Support Contact:
(66 2) 661-3900/1/2 ext 5125
Customer Information Center:
(66 2) 661-3900/1/2 ext 3232

Turkey:
Hewlett-Packard Company
Bilgisayar Ve Ölçüm Sistemleri AS
19 Mayis Caddesi Nova
Baran Plaza Kat: 12
80220 Sisli-Istanbul
Phone: (90 212) 224 59 25
Fax: (90 212) 224 59 39

United Kingdom:
Hewlett-Packard Ltd.
Cain Road
Bracknell
Berkshire RG12 1HN
Phone: 01 334 369222
Fax: 01 344 363344

Venezuela:
Hewlett-Packard de Venezuela CA
Los Ruices Norte
3A Transversal
Edificio Segre Caracas 1071
Phone: (58 2) 239 42 44
Fax: (58 2) 239 30 80
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INDEX

A
accessories, ordering B-13
Actual Size display  4-15
adding paper 1-8, 2-24
adjusting paper guides 2-29
alternative installation 1-14
ammonia  5-28
annotating pages 4-1
Annotation Tool Bar 4-14
annotations

error message 5-13
fax 3-8
finding 4-3
PaperPort 3-8
rotated pages  4-6
undoing 4-7

applications
exit error message 5-11
PaperPort supported  A-3

Arrange
Desktop  4-9
icon  4-3

Arrange button  4-3
arranging items  4-9
automatic document feeder 4-10
automatic saving 4-5
B
back-up copies 4-5
background, color  4-4
bit depth, scanner resolution  3-14
Bit Depth, setting 3-14
black and white 3-2, 3-14, 4-15
blank pages  5-18, 5-19
BMP file format 4-5
bond paper 3-1
brightness

adjusting 3-4, 3-5
image  3-4, 5-20

Browse button 4-3
Browse icon  4-3
browsing folder contents 3-10
business cards 3-1
busy system, error messages 5-13
buttons

Browse  4-3
Command Bar 4-3, 4-4
Desktop  4-3
Duplicate 4-3
Find  4-3
SEE Front Panel
OLE Return 4-3
Page  4-3
Rotate 4-3
Scan 4-3
Settings 4-3
Stack  4-3, 4-10
Unstack  4-3
Unstack 1 4-3

C
cables

interface  1-2
SEE parallel cables
troubleshooting  5-1

calibrating 5-22
calibration file

error message 5-11
troubleshooting  5-11

canceling a print job 2-28
carrier sheet 3-1
CFCs (Chloroflorocarbons) A-5
character shadows 5-16
Chloroflorocarbons (CFCs)  A-5
cleaning 5-29
clearing data 2-28
clipboard 3-12

error message 5-11
troubleshooting  5-11

closing PaperPort, error message 5-12
clothing, removing toner  5-28
codes, formatting problems  5-23
collate copies 3-6
color

image  4-14
Color Screen option 4-4
Command Bar 4-2, 4-3, 4-5
comments 4-13
computer, scanning to 3-7
connecting

parallel cable 1-9
connector, power 1-5
contents, list in folders  3-10
contrast

adjusting 3-4
image  3-4, 5-20

Contrast slider 3-5
control panel

indicator lights 2-21
tasks 2-22
troubleshooting  5-5

copier link 3-4
copier utility 1-1
copies

SEE ALSO direct copies
enlarging 3-4
making multiple 3-3
manipulating images 3-4

copy  1-1
adjusting quality 3-4, 3-13
adjusting quantity 3-4

Copy As Text
command 3-12

copying
documents 1-1
SEE ALSO duplicating
HP LaserJet Companion Copier 3-4
items 4-3, 4-9
items to folders  3-9
pages in stacks  4-13
problems  5-20

cover, identifying 1-4
creating electronic folders 3-10
creator name 4-13
curling

envelopes 2-26
reducing  2-29, 5-18
transparencies 2-29
when duplexing 2-27
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custom installation 1-14
Custom Mode 3-13
custom sized media  2-23
custom sized paper, printing 2-29
customizing

PaperPort preferences  4-4
cutting selections 4-14
D
damage

files 5-12
HP LaserJet 6L printer  1-2
HP LaserJet Companion 1-2
pages  5-11

damaged
data error messages  5-13
error messages link 5-12
image error message 5-11

data  5-13
clearing 2-28
unprinted 5-5

data light
SEE indicator lights
status  2-21

DaVinci e-mail problems  5-24
Declaration of Conformity A-8, A-9
default settings 2-28
defaults

Main Folder  3-10
settings  3-5

deleting
electronic folders 3-10
folders  3-10
items  4-5, 4-6
pages  4-11

deleting print job 2-28
deselecting items  4-8
Desktop

Arrange  4-9
button  4-3
error messages  5-11, 5-13
icon  4-3
View  4-1, 4-2, 4-5

Desktop file troubleshooting  5-13
Direct Copy 3-2, 5-20

resolution 3-2
disk errors 5-11, 5-12
display size 4-15
displaying

elements 4-5
items in folders  3-10

dithered resolution 3-14
Document Navigator  4-14
documents

copying  1-1
faxing  1-1
feeder, automatic  4-10
filing  1-1
SEE ALSO items
organizing  1-1
SEE ALSO pages
reading 1-1
scanned, viewing 4-1
scanning  3-7

double sided printing
SEE duplexing

DPI (dots per inch)
image 4-14
scanner 3-14

drag-and-drop stacking 4-10
DRAM memory cards  1-20

SEE ALSO memory cards

drivers
fax  5-23

dropouts  5-17
duplex printing 2-27

SEE duplexing
duplexing 2-27

avoiding curls  2-27
multiple paper feeds  2-27
paper jams  2-27
tips 2-27

Duplicate button 4-3
Duplicate icon  4-3
duplicating

SEE ALSO copying
duty cycle A-1
E
e-mail

problems  5-23
troubleshooting  5-23

EconoMode  2-30
editing

converted scanned text 3-11
text 3-11, 3-12

electronic folders
copying items 3-9
creating 3-10
deleting  3-10
displaying contents 3-10
renaming  3-10
using 3-9

energy consumption  A-1, A-5
Energy Star compliance  A-5
enlarging images 3-4, 4-14, 4-15
envelopes 2-23

output options 2-24
size  2-23
sizes 2-23
wrinkling 2-26

environment
operating A-1
protecting A-5
storage A-1

Environmental Product Stewardship A-5
error conditions, removing 2-28
Error Light 2-21

SEE indicator lights
error messages

PaperPort 5-11
PaperPort software  5-11
SEE ALSO problems
SEE ALSO support
SEE ALSO troubleshooting

executive paper size 2-23
exit, application error messages  5-11
exporting

format, PaperPort A-3
items  4-5, 4-6
troubleshooting  5-25

Express Exchange B-12
F
faded print 2-30
fax

documents 1-1
error messages  5-12
links  3-8
problems  5-25
reading 3-8
troubleshooting  5-23

fax links
troubleshooting  5-23
using 3-8
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features
PaperPort 4-1

feed mechanism 3-1
file, error message  5-11
files

damage  5-12
error message 5-12, 5-13
formats  4-5, 5-25
in folders  3-9
problems  5-25

filing
documents 1-1
in folders  3-9

Find
button 4-3
icon  4-3

Fit To Page 3-5
Fit to Window display 4-15
flipping items  4-6
folder icon 3-10
folders

copying items between  3-9
creating 3-10
deleting  3-10
displaying 4-5
displaying items in 3-10
electronic 3-9
SEE ALSO electronic folders
filing in 3-9
hiding  4-5
list of contents 3-10
renaming  3-10

format
file  4-5
problems  5-23

Front Output Slot
capacity A-1
identifying 1-3
using  2-24

Front Panel
in troubleshooting  5-5
SEE indicator lights
messages 5-5

Front Panel Button
identifying 1-3, 2-22
using  2-22

G
Go To Page 4-14
graphics, printing problems  5-18
grayscale 3-2, 3-14, 4-15
guides, paper 1-4, 1-8
H
hardware error  5-5, 5-15
help

SEE online help
help files, selecting 1-14
hiding

elements 4-5
highlighting  4-7, 4-14
HP Customer Information Center B-13
HP Direct Ordering B-13
HP LaserJet Paper, ordering B-13
HP LaserJet Printer Cable, ordering B-13
HP media

ordering B-13
using  2-29

HP Multipurpose Paper
ordering B-13

HP paper specification guide  B-13
HP Repair Services B-12
I
icons

Command Bar 4-3, 4-4
image quality 1-6
image sensor

cleaning 5-29
identifying 1-4

Image Sensor Roller  1-4
images

black and white  3-2
color  4-14
enlarging 4-14, 4-15
inverting  4-15
linking to HP LaserJet Companion Copier 3-4
manipulating 3-4
quality 3-4, 3-14, 5-20
reducing  3-4, 4-14, 4-15
resolution 3-13, 3-14, 4-14
rotating and flipping  4-6
size  4-15, 5-11
size, problems printing  5-20
troubleshooting  5-20

importing
fax problems  5-25
faxes  3-8
format, PaperPort A-3
problems  5-25

indicator lights
blinking  2-22
SEE front panel
identifying 1-3
status  2-22
troubleshooting  5-5

Input Slot 1-4
inserting

pages in stacks  4-12
installation

custom 1-14
PaperPort problems  5-14
PaperPort software 1-11
testing 1-16
troubleshooting  5-14
typical 1-14

installing
software 1-11, 1-13
toner cartridge 1-6
using CD-ROM 1-11
using disks 1-13

interface cable
identifying 1-2
troubleshooting  5-1

internal mirror  5-16
interrupt print job 2-28
inverting images 4-15
irregular sized paper 3-1
items

SEE ALSO pages
arranging  4-9
converting scanned text 3-11
copying to folders  3-9
deleting  4-5, 4-6
deselecting 4-8
display size  4-15
displaying in folders  3-10
SEE ALSO documents
duplicating 4-9
duplicating 2-8  4-9
editing 3-11
faxes  3-8
filing in folders 3-9
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flipping 4-6
moving 4-9
organizing  4-10
panning  4-15
PaperPort 4-1
rotating 4-6
saving 4-5
scanning  4-10
scrolling between  4-14
selecting 4-8
stacking 4-10
Summary Information  4-13
titles  4-5

J
jams, paper 3-1
K
keywords

Summary Information  4-13
Kingston Lock Latch, identifying 1-5
L
labels  3-1

attaching to printer  1-7
printing 2-29
tips for printing 2-29

landscape
SEE paper orientation

laser safety statement A-7
left rotation 4-6
legal sized paper 2-23
letter paper size 2-23
letterhead

printing on  2-26
license agreement B-14
lights

SEE indicator lights
Link Bar

displaying 4-5
hiding  4-5
illustration 4-2

links
e-mail problems 5-23
error messages  5-12
fax  3-8
fax problems  5-23
HP LaserJet Companion Copier 3-4
OCR  3-11
PaperPort error message  5-13
spreadsheet 3-11
word processing 3-11

lists, folder contents 3-10
loading

paper input bin 1-8
single sheet input slot 2-25

loading paper 1-8
lock latch  1-5
Lotus

cc:Mail 5-24
Notes e-mail 5-23

M
magazine pages 3-1
magnification, page  4-14, 4-15
Main Folder  3-10
maintenance 5-28
makedisk utility, using  1-12
making floppy disks 1-12
manual feed mode 2-28

pause when printing 2-28
when duplexing  2-27

Maximize Window at Startup option 4-4
maximum paper size A-1
media

minimum size  2-29
moisture content 2-26
ordering B-13
SEE ALSO paper
sizes 2-23
special 2-29

memory
adjusting 1-20
expansion A-1
printer  A-1
setting 1-20
troubleshooting  5-12

memory cards
DRAM installation  1-20
installing 1-20
ordering B-13
specifications 1-20
speed  2-22

Memory Expansion Cover 1-20
messages, PaperPort error  5-11
minimum paper size A-1
monitor, color 4-4
moving

between pages 4-11
items  4-8, 4-9
pages  4-11
undoing  4-7

MS Mail 5-24
multiple copies, printing  1-1, 3-4
multiple paper feeds, frequent 5-6
multiple-page scanning  4-10
N
names

folders  3-10
items  4-5

navigating within stacks 4-11
Navigators 4-14
network printers

direct copies 1-16, 3-2
troubleshooting  5-20

newsprint, scanning  5-29
noise level A-1
notes, adding 4-14
Novell Group Wise 5-24
O
OCR

error message 5-13
link 3-11
link accuracy 5-23
problems  5-23

OCR software 1-1
non-English  1-2
troubleshooting  5-23

OLE Return button  4-3
OLE Rtn icon  4-3
One-Minute Guide  1-17
online help

How Do I 1-19
overview 1-19
PaperPort software  1-17, 1-19
status window 1-19
troubleshooting  1-19
using 1-19

operating environment A-1
operating tasks  3-1
operation, troubleshooting 5-9
options

PaperPort 4-4
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PaperPort preferences 4-4
Summary Information 4-13

ordering
accessories  B-13
information  B-13
supplies B-13

organizing
documents 1-1
items 4-9, 4-10

output paper path 2-24
Output slot, identifying 1-4
ozone emission  A-5
P
Page button  4-3
page guides 1-4
Page icon  4-3
Page Navigator  4-14
Page Scroll Arrows 3-5
page supports 1-4
Page View 4-1, 4-5, 4-14
pages

copying in stacks 4-13
copying multiple 3-3
damaged error message 5-11
deleting  4-11
SEE ALSO documents
inserting in stacks 4-12
SEE ALSO items
magnification 4-14
moving 4-11
moving between 4-11
reordering in stacks 4-12
replacing 4-11
rotating 4-6
scanning  4-10
scrolling between 4-14
width  3-13

Palette, Tool
displaying 4-5
hiding  4-5

panning items 4-15
paper

adding 1-8, 2-24
bond 3-1
centering 1-8
custom-sized 2-23
irregular sized  3-1
jams  3-1
length  3-13
lightweight 3-1
loading  1-8
ordering B-13
orientation  2-23
realigning  1-8
recycled  2-23, A-6
release lever  1-5
removing  1-8
selecting 2-23
size  3-13, 5-9
sizes 2-23
width  3-13

Paper Edge Guides 1-4
paper guides

adjusting 2-29, 5-4
centering 2-25
identifying 1-3
using  1-8

Paper Input Bin
attaching label 1-7
capacity A-1
identifying 1-3
using  2-24

Paper Input Support
identifying 1-3

paper jams
avoiding 3-1
causes  5-3
clearing 5-3, 5-10
frequent 5-6
paper will not feed  5-4

Paper Output Bin
capacity A-1
identifying 1-3
using  2-24

Paper Output Support
identifying 1-3

Paper Path Lever
identifying 1-3
lower position  2-24
position  2-24
upper position 2-24

Paper Pick Roller  1-4
Paper Release Lever

identifying for paper 1-5
using  5-10

paper specification guide  B-13
Paper Supports 1-4, 1-8
paper texture  5-15, 5-16
Paper Tray 1-4, 3-1
Paper Width slider 3-13
PaperPort

Command Bar 4-3
deleting items  4-6
Desktop View 4-8
displaying and hiding elements 4-5
error messages 5-11
fax link 3-8
features  4-1
installing software 1-11
OCR link 3-11
Page View  4-14
preferences 4-4
saving items 4-5
settings  5-20
specifications A-3
spreadsheet link 3-11
stacks 4-10
Summary Information 4-13
thumbnails 1-17
undoing actions  4-7
Viewer 4-16
views 4-2
word processing link 3-11

PaperPort Printer link 3-2
PaperPort software

annotations 3-8
error messages 5-11
online help  1-17
reading faxes  3-8
testing 1-15
tutorial 1-17
uninstalling  1-18

parallel cable
connecting to printer 1-9
defective  5-5

identifying 1-2
parallel cables, connecting  1-9
parts, ordering B-13
pasting

error message 5-11
selections 4-14
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pausing 2-28
pausing printing 2-28
PCL driver, selecting 1-14
photographs

scanning  3-1
photosensitive drum  5-16
Poland, sales and service  B-17
postcards, output options  2-24
power

connector 1-5
consumption A-1, A-2
cord 1-2
cord, troubleshooting  5-1
requirements A-1, A-2

Power Connector  1-5
preferences

PaperPort 4-4
preparing for printing  2-23
print density, adjusting 5-17
print job, deleting  2-28
print media 2-23

SEE envelopes
SEE paper
SEE transparencies

print quality
media 2-23

print resolution A-1
print speed  A-1
print, faded  2-30
printable area  5-20
printer

dimensions A-1
messages  5-5
parts, recycling  A-6
specifications A-1

printer cable, ordering B-13
Printer Door, identifying 1-3
printer drivers

adjusting memory setting 1-20
printer software

installing for Windows 1-13
not configured 5-5

printers
copying to 3-2
network  1-16, 3-2, 5-20
PaperPort supported  A-3

printing
custom sizes 2-29
items  4-8
labels  2-29
on both sides of paper 2-27
pausing  2-28
problems  5-20
self-test page  1-15, 5-2
single copies 3-2
special media  2-29
stopping 2-28
tasks 2-27
transparencies  2-29

problems
Direct Copy 5-20
e-mail 5-23
SEE ALSO error messages
exporting 5-25
fax  5-25
files 5-25
format 5-23
HP LaserJet Companion 5-8, 5-29
importing 5-25
OCR  5-23
printing  5-20
Windows 5-14

Q
quality

adjusting 3-13
copy 3-4, 3-5
scanning  3-13, 5-20

R
RAM (Random Access Memory)  1-2
reading

documents 1-1
faxes 3-8

ready light
SEE indicator lights

recalibrating  5-20, 5-22
recycling

paper A-6
plastics  A-6
U.S.A. A-6
worldwide  A-6

redistributing toner  2-30
Redo  4-7
reducing images 3-4, 4-14, 4-15
Release Levers

identifying for cover  1-4
using 5-10

removing
error conditions 2-28
toner from clothing 1-6, 5-28

renaming electronic folders  3-10
reordering pages in stacks 4-12
repairs B-11, B-12
replacing pages 4-11
resetting printer 2-28
resolution

adjusting 3-13
custom 3-14
direct copies 3-2
image 4-14
print A-1
reducing  5-5
setting 3-14

resume printing 2-28
retitle items 4-5
returning printer B-12
reversing images 4-15
right rotation 4-6
rollers

cleaning 5-29
identifying 1-4

Rotate button  4-3
Rotate icon  4-3
rotating items 4-6
S
safety specifications A-4
sales offices, worldwide  B-15
saving

automatic 4-5
desktop preferences 4-4
items  4-5, 4-6

Scale slider  3-5
scale, copy 3-5
Scan button 4-3
Scan Mode  3-13
scan quality, adjusting  3-13
Scan to Desktop option  4-4
Scan to Page View option 4-4
scanned documents, viewing  4-1
scanned text, converting 3-11
scanning

documents 3-7
items  4-10
newsprint 5-29
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quality 3-13, 5-20
tips 3-7
to computer  3-7
to HP LaserJet Companion Copier 3-4
to printer  3-2
troubleshooting  5-8, 5-11, 5-20

screen, color  4-4
scroll arrows  3-5
scrolling

between items and pages 4-14
through item 4-15

selecting items 4-8
self-stick notes  3-1
self-test page 1-15
sending faxes  3-8
Sensitivity slider 3-13
sensor, image  1-4
serial number 1-11
service information B-11
setting up HP LaserJet 6L printer 1-6
settings  3-13
Settings button  4-3
settings, default 2-28
Show Text with icons option 4-4
Show Tool Tips option 4-4
single copies, printing 3-2
single page scanning  4-10
Single-Sheet Input Slot

for letterhead  2-26
identifying 1-3
using  2-23, 2-25

size
copy 3-5
display 4-15
exported file problems  5-25
image  4-14
image error message 5-11
image, problems printing 5-20
paper 2-23, 3-1, 3-13, 5-9
printer A-1

sliding paper guides  1-8
smudges

in printing  5-15
software

installing HP LaserJet Companion 1-11
installing PaperPort 1-11
license agreement B-14
uninstalling  1-18

specifications
electrical  A-1
environmental A-1
HP LaserJet Companion A-2
PaperPort A-3
printer A-1
safety  A-4

spreadsheet
applications 3-11
PaperPort link 3-11

Stack button  4-3
Stack icon  4-3
Stack Selected Items command 4-10
stacks

copying pages  4-13
creating 4-10
in folders  3-10
inserting pages 4-12
navigating within 4-11
PaperPort 4-1
reordering pages  4-12
Summary Information 4-13
unstacking  4-11

standard installation 1-13
Status Bar

displaying 4-5
hiding  4-5
illustration 4-2, 4-14

status indicator lights 2-22
status window 1-14
status window messages 1-19
stop printing 2-28
stopping a print job 2-28
stopping scanning  1-16, 3-7
storage environment A-1
streaks, in printing 5-15
Summary Information  4-10, 4-11, 4-13
supplies, ordering B-13
support

SEE error messages
SEE problems
SEE troubleshooting

support, worldwide  B-15
supports, paper 1-4

switching views  4-2
system memory

error message 5-12
troubleshooting  5-12

system requirements  1-2
T
tasks 3-1
tasks, printing 2-27
testing

HP LaserJet Companion 1-15
HP LaserJet Companion installation 1-16
installation 1-16
PaperPort software 1-15
printer 1-15

text
converting scanned 3-11
editing 3-11, 3-12
not clear  5-20
pasting 3-12

thresholded resolution  3-14
thumbnails

folder contents 3-10
items in folders  3-10
PaperPort 1-17, 4-1

TIFF file format 4-5
titles

items 4-5
Summary Information 4-13

To PC button 1-4
To PC connector  1-5
To Printer button  1-4
To Printer connector 1-5
toner

density 5-15
redistributing  2-30
removing from clothing  5-28

toner cartridge
defective  5-28
expected toner life 2-30
exposing to light 1-6
extending life 2-30
installing 1-6
life span 2-30
ordering B-13
recycling 2-30
removing sealing tape  1-6
returning  B-12
storing  1-6
warranty  B-12

Tool Palette
displaying 4-5
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hiding  4-5
transparencies

capacity 2-24
output options 2-24
printing 2-29
tips for printing 2-29

tray, paper 1-4
troubleshooting

basic steps  5-1, 5-5
blank pages  5-18
checklist 5-1
common problems  5-1
SEE ALSO error messages
HP LaserJet Companion operation 5-9
installation 5-14
SEE self-test page
wrinkled pages 5-18

True Type fonts, selecting 1-14
tutorial, PaperPort software 1-17
two-sided printing 2-27
typical installation 1-14
U
Undo  4-7
uninstall

software 1-18
utility 1-18

Uninstall HP LaserJet Companion icon  1-18
Uninstall PaperPort icon  1-18
Unstack 4-11
Unstack button  4-3
Unstack Current Page command  4-11
Unstack icon  4-3
unstacking stacks  4-11
Use Gray Dialog Background option 4-4
V
Viewer, PaperPort 4-16
views

Desktop  4-8
Page 4-14
PaperPort 4-1
switching between 4-2

VIM (Virtual Interface Messaging) 5-24
W
wake up printer 1-15, 5-2
warranty B-11, B-12

hardware service B-12
toner cartridge  B-12

warranty period B-11
white-on-black images 4-15
white-out 3-1
window, PaperPort 4-4
Windows

error message 5-11
problems  5-14
restarting 5-14
unstable 5-11

Windows 3.1x
installation requirements  1-2
installing HP LaserJet Companion software 1-11
installing printer software  1-13

Windows 95
installation requirements  1-2
installing HP LaserJet Companion software 1-11
installing printer software  1-13

word processing
applications 3-11
PaperPort link 3-11

word processor links
configuring 5-23
troubleshooting  5-23

WordPerfect Office 5-24
worldwide sales and service offices B-15
Z
Zoom Navigator 4-14, 4-15
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